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Abstract

Bate, Lisa J.; Garton, Edward O.; Wisdom, Michael J. 1999. Estimating snag and
large tree densities and distributions on a landscape for wildlife management.
Gen. Tech. Rep. PNW-GTR-425. Portland, OR: U.S. Department of Agriculture,
Forest Service, Pacific Northwest Research Station. 76 p.
We provide efficient and accurate methods for sampling snags and large trees on a
landscape to conduct compliance and effectiveness monitoring for wildlife in relation to
the habitat standards and guidelines on National Forests. Included online are the necessary spreadsheets, macros, and instructions to conduct all surveys and analyses pertaining to estimation of snag and large tree densities and distributions at the subwatershed scale. The methods focus on optimizing sampling effort by choosing a plot size
appropriate for the specific forest conditions encountered. Two methods are available
for density analysis. Method one requires sampling until a desired precision level is
obtained for a density estimate. Method two is intended for use in areas that have low
snag densities compared to Forest plan targeted densities. After taking a minimum of
60 samples, one may test for a significant difference between the estimated and targeted densities. In addition, data can be used to calculate a distribution index. The value
obtained from the distribution index indicates whether the current distribution of target
snags and large trees across a subwatershed is adequate to meet the habitat needs of
territorial cavity-nesters and other wildlife species. Wildlife use also may be evaluated.
Keywords: Density, distribution, foraging, nesting, monitoring, sampling technique, snag,
large tree, woodpecker, wildlife management, wildlife use.
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Introduction

A wide variety of wildlife depend on snags and large trees for survival and reproduction.
In the Blue Mountains of Oregon and Washington, for example, 62 species of birds
and mammals use snags or large trees for roosting, denning, feeding, or related life
functions (Thomas and others 1979). Woodpeckers are an especially important group
of species that depends on snags and large trees, and whose role in forested ecosystems is integral to the continued health of such systems. As primary cavity-nesters,
woodpeckers excavate nest and roost sites for themselves and many other species.
An absence of viable woodpecker populations in fact, means an uncertain future for
secondary cavity-nesters, or nonexcavators. Woodpeckers often are referred to as
indicator species because it has been assumed that if woodpecker populations are
maintained at viable levels, secondary cavity-nesting populations also will be present
at viable levels (Thomas and others 1979).
Currently, the nesting and roosting needs of woodpeckers and other cavity-nesters are
assumed to be met by controlling only the density of snags, standing dead trees, on
public lands. This is based on a snag model developed by Thomas and others (1979);
this model assumed a positive, linear relation between woodpecker and snag abundance in the Blue Mountains of Oregon. This relation was confirmed by Mannan and
others (1980) for forests in western Oregon (as stated in Nietro and others 1985).
The model, however, did not account for the foraging needs of woodpeckers and other
cavity-nesters, and more recent studies have shown that foraging structures can differ
from nesting and roosting structures for woodpeckers (Bate 1995, Bull and Holthausen
1993, Dixon 1995). For example, large trees (>20 inches [51 cm] diameter at breast
height [d.b.h]) are also critical for woodpecker populations; large trees develop deep
furrows that harbor increased arthropod densities (Bull and others 1986, Mariani and
Manuwal 1990). Some species, such as the white-headed woodpecker (Picoides
albolarvatus), depend on the seeds produced by mature ponderosa pine (Pinus
ponderosa Dougl. ex Laws.) for autumn foraging (Dixon 1995). In addition, other
species such as the pileated woodpecker (Dryocopus pileatus) select large hollow
trees for roosting (Bull and others 1992). Finally, retaining large trees across a
landscape provides a continual source of large snags, even in areas managed
primarily for timber resources.
Although most resource specialists recognize the need to retain adequate densities of
snags and large trees across a landscape, these structures have declined in abundance
for various reasons (Hann and others 1997). Large trees are targeted for removal
during timber harvesting. Snags also have been systematically removed from public
lands. Historically, snags have been reduced because of even-age management
techniques (Titus 1983), fuelwood cutting, and the elimination of snags as a source
of disease and insect pests (Dickson and others 1983, Ffolliot 1983, Styskel 1983).
In addition, Hope and McComb (1994) found that snag retention programs on National
Forests are hampered by problems with safety, funds, and inconsistent standards and
guidelines. Consequently, density, size, and condition of snags on National Forests
often fail to meet the snag (Morrison and others 1986) and woodpecker guidelines
outlined in Forest plans (Bate 1995).
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Cavity-nesting birds are not the only species affected by reduced snag densities.
Commodity values of timber can be reduced by insect damage. Most cavity-nesters
are insectivores, and have proven instrumental in preventing, or retarding, local insect
outbreaks (Beebe 1974, Otvos 1979). Some species of woodpeckers will aggregate in
areas where insect outbreaks are occurring, thus accelerating the decline of the insect
population (Otvos 1979). In addition, as foraging woodpeckers remove the bark of
beetle-infested trees by chipping and probing, the microenvironment of the remaining
beetle eggs and larvae is altered. The remaining eggs and larvae may be more
susceptible to mortality caused by parasites and extreme temperature fluctuations
(Otvos 1979). Thomas and others (1979) provided additional compelling arguments
and evidence in support of maintaining viable populations of woodpeckers and other
insectivores for their benefits to forest-based economies.
National Forests are required to maintain viable levels of native wildlife populations
on public lands. This was the objective in 1974 when the Forest and Rangeland
Renewable Resources Planning Act (RPA) became law (Forest and Rangeland
Renewable Resources Planning Act 1974). Then in 1976, the National Forest
Management Act was passed as an amendment to the RPA. This second law
requires the preparation of forest plans that include periodic evaluation and
monitoring of management objectives, standards, and guidelines for National Forest
Service lands and its resources (U.S. Laws, National Forest Management Act 1976).
Woodpeckers, an important wildlife resource because of their role as indicator
species and controlling agents of forest insect pests, are a primary focus of the
Forest Service’s monitoring efforts.
To help ensure that viability requirements are met, targeted woodpecker and snag
densities are set by each National Forest based on land use allocation and the forest
community type. Many National Forests use the findings from the Blue Mountains for
their target guidelines (Thomas and others 1979). For example, at the Deschutes
National Forest, old-growth and riparian areas are managed for 100 percent of the
woodpecker potential maximum population (PMP)(Thomas and others 1979), whereas
in even-aged ponderosa pine harvest units, visual corridors, and deer management
areas, 40 percent of the PMP is the objective (Deschutes National Forest plan 1992).1
In contrast, forests west of the Cascade Range such as the Willamette National Forest
aim to maintain habitat capability at the 40 percent PMP (Nietro and others 1985) level
on all subwatersheds (Willamette National Forest plan 1992).2
There are three types of monitoring in National Forests: implementation, effectiveness,
and validation. Implementation, or compliance, monitoring determines whether a
National Forest complies with the objectives, standards, and guidelines outlined in
their Forest plan. For example, Were a minimum of 0.9 snags per acre (2.2 snags per
ha) left in a stand after timber harvest? Effectiveness monitoring refers to periodically
collecting the necessary data to determine whether management actions are producing
the desired effect. For example, Are woodpeckers present at 40 percent of their PMP
(Thomas and others 1979) level when 0.9 snags per acre (2.2 snags per ha) are left?
1

Deschutes National Forest, Bend and Fort Rock Ranger
Districts, 1230 NE 3d, Suite A-262, Bend, OR 97701.
2 Willamette National Forest, Blue River Ranger
District, Blue River, OR 97413.
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Validation monitoring collects information to support, or refute, the assumptions of the
guidelines and objectives stated in the Forest plan for a particular species. For example, Does woodpecker abundance respond in a positive, linear fashion to increasing
snag densities? (Wisdom and others, in prep.).
Monitoring requires both time and money. If resource specialists are to monitor woodpecker habitat, therefore, they need efficient and statistically valid methods to achieve
monitoring objectives. Key decisions managers must make before sampling snags and
large trees are the shape and size of plot that statistically is most efficient. Bull and
others (1990) tested the efficiency and accuracy of both fixed- and variable-radius
circular plots to determine snag densities. They found that 1-acre and variable plots,
with a factor-5 prism, worked best for areas with snag densities ranging from 0.7 to 2
snags per acre (1.7 to 4.9 snags per ha). In areas obscured by vegetation, or in steep,
difficult terrain, however, it may be difficult to accurately count all snags in these plot
sizes. In addition, Krebs (1989) states that most ecologists have found that long, thin or
rectangular plots work better than circular or square plots in the same area. The habitat
components of a forest are never uniformly distributed; rather, there are often clumps, or
patches, of habitat components such as snags and trees. Consequently, rectangular
plots are better for sampling because they cross more clumps of snags or trees, rather
than encircling, or missing, them completely. This results in a lowered variance, which
translates into smaller sample sizes. Rectangular plots therefore are recognized as the
optimal plot shape for sampling in patchy habitats. For the optimal plot size, however,
each forest situation needs to be analyzed independently (Krebs 1989).
This report provides resource specialists with efficient and accurate methods to sample
snags and large trees with the use of rectangular plots. This report also was written in
response to the concern that many National Forest subwatersheds fail to provide the
necessary densities of snags and large trees to maintain viable populations of cavitynesters (Bate 1995, Morrison and others 1986). Currently, most National Forests east of
the Cascade Range use the snag densities recommended by Thomas and others
(1979) for woodpecker management. Bull and Holthausen (1993), however, found that
pileated woodpecker densities were less than what this model would have predicted by
snag numbers alone. In addition, recent studies suggest that current snag density
guidelines may be too low to produce the desired levels of woodpecker abundance
because the guidelines focus only on their nesting needs (Bull and others 1997). The
primary purpose of these methods is therefore to conduct compliance and effectiveness
monitoring for woodpeckers in relation to the habitat standards and guidelines of
National Forests.
The necessary spreadsheets and macros (Excel Version 5.0)3 to conduct all analyses
pertaining to snag and large tree densities and distributions on a landscape can be found
online at http://www.fs.fed.us/pnw/snags. Guidelines for stratification are included to
reduce sampling effort and to increase precision of an estimate (Krebs 1989). Methods
presented will help resource specialists to optimize their sampling effort by choosing a plot
size that minimizes the number of samples required for their specific forest conditions.
3
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Two methods are available for density analysis. Method one requires sampling until a
desired level of precision is obtained for a density estimate, for example, a density
estimate that could be within 20 percent of the true mean, 90 percent of the time.
The second density analysis method was developed for sampling in areas that have
low snag densities compared to targeted densities. After taking a minimum of 60 samples, a resource specialist may test for a significant difference between the estimated
and targeted densities. In addition, resource specialists can use their data to calculate
a distribution index. The Distribution Index will estimate how evenly distributed target
snags or large trees are across a landscape; this index is based on the proportion of
the sampled landscape supporting target snags or large trees.

General
Information
Files Online

Four files will accompany each report. They can be found online at http://www.fs.fed.us/
pnw/snags. Both English and metric versions are available. The file names for the
English versions are (1) Estimate.xls, (2) Single.xls, (3) Strate.xls, and (4) Append2.doc.
The file names for the metric version equivalents are (1) Estimatm.xls, (2) Singlem.xls,
(3) Stratm.xls, and (4) Append2.doc. Within these files are the data forms, data sets,
macros, and spreadsheets necessary for snag and large tree density and distribution
analyses on landscapes. The files named *.xls were created and are intended for use in
Microsoft Excel Version 5.0. The Append2.doc is a Microsoft Word Version 6.0c document. It contains detailed explanations of each item on the field form and has been
made available on disk for modification for specific forest conditions. Please make backup copies of all files before beginning any data entry or analyses.
The file Estimate.xls (Estimatm.xls) contains no data; this is where your own data
should be entered.
Two files containing data sets are provided for tutorial purposes: (1) Single.xls (Singlem.xls)
and (2) Strate.xls (Stratm.xls). The file Single.xls (Singlem.xls) contains a subset of the
data collected from a 900-acre (364-ha) old-growth ponderosa pine forest. It represents an
example of a landscape area smaller than the typical subwatershed. The file Strate.xls
(Stratm.xls) contains a subset of the data collected from a 4,347-acre (1760-ha) Douglas-fir
(Pseudotsuga menziesii (Mirb.) Franco)/western hemlock (Tsuga heterophylla (Raf.) Sarg.)
subwatershed. This subwatershed was delineated into three strata (Bate 1995). These two
files are identical in every way except for the data sets they contain.
All working spreadsheets are protected with the exception of the Optimal sheet.
Only the shaded areas on each of these spreadsheets therefore can accept alphanumeric
information from you. This protects the formulas and format necessary to conduct all
analyses. In the “Computer Analysis” section of this report, users will find the background,
statistics and discussion of each macro and spreadsheet. In the “Tutorial” sections,
detailed operating instructions are given for using the two sample data sets provided.

Sampling Applications
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Although these sampling techniques were designed to address objectives for the management of woodpeckers, these techniques may be used for any wildlife species associated with snags and large trees. For example, a manager may want to determine the

difference in large, hollow tree densities between two subwatershed areas for black
bears (Ursus americanus). These sampling techniques would be appropriate for this
objective.
In addition, these techniques may be used to complement the information collected in
other monitoring projects. For example, the USDA Forest Service’s current vegetation
survey (USDA Forest Service 1993) collects Forest habitat data from the same permanently established plots every 8 years. These plots are located on a 1.7-mile (2.7-km)
grid across Oregon and Washington on National Forest Service lands. The final product of both of these monitoring techniques could be converted to similar units of
measurement (e.g., no. per acre [no. per ha]) to provide additional baseline data for
resource specialists.
General Snag and
Large Tree Sampling
Guidelines

A condensed outline of the guidelines for sampling snag and large trees can be found in
appendix 1. A more detailed discussion of the topics in the outline follows.

Landscape Definition
and Selection

The first step in sampling snags and large trees is to select the area to be surveyed.
Our snag and large tree sampling methods were developed to be compatible with the
intended sampling unit for the Forest Service’s woodpecker monitoring program, which
was defined as a landscape ranging from 3,000 to 7,000 acres (1215 to 2834 ha) (Bull
and others 1991). Our sampling methods also are intended for use on a subwatershed
scale with some slight modifications. See the “Establishing Transects” and “Compare to
Target” sections for details. Subwatersheds average nearly 20,000 acres (8097 ha)
within the interior Columbia basin (Quigley and others 1996) but can be as small as
1,000 acres (405 ha).
The area to be sampled, however, need not be a delineated subwatershed. For example, a manager may want to know the estimated snag and large tree density within an
old-growth Research Natural Area that comprises only 900 acres (364 ha). These
methods will work for this situation as well. Our sampling methods, however, are not
intended for small-scale sampling such as an individual stand (<100 acres [40 ha]);
complete counts are more appropriate in individual stands.

Sampling Objectives

After a landscape area has been selected for sampling, the next step is to specify the
sampling objectives. Doing this will dictate the stratification process and can aid in the
decisionmaking process for optimal plot size. The following questions should be
answered before sampling begins: (1) What size class of snags or large trees will be
surveyed (e.g., what d.b.h. and height)? (2) What condition of snags and large trees will
be surveyed? (e.g., both hard and soft snags? Hollow trees? All trees?) (3) Should any
species be excluded (e.g., if a particular tree species is known to provide little, if any,
wildlife value, should it be excluded from your sampling program)? and (4) Should signs
of wildlife use be recorded (e.g., woodpecker foraging and nesting signs)? Your choices
will ultimately determine the amount of time and resources needed to obtain a density
estimate with a desired level of precision. In addition, several of these choices will
affect the outcome of the Compare to Target density estimate test and the Distribution
Index found in the “Computer Analysis” section of this paper.
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Landscape
Stratification

Perhaps the most critical step in any snag or large tree sampling program is deciding
on the stratification process. Although the initial investment of time spent in the stratification process can be large, if done correctly, this process should reduce the final
requirement of resources and provide a more precise density estimate (Krebs 1989).
Before stratification of a landscape begins, however, we recommend checking with
local foresters. Field-level foresters often stratify for other sampling needs, and their
delineations may work well for purposes outlined here.
If the landscape is homogeneous throughout in regard to snag or large tree densities,
there is probably little to be gained by stratifying. Whether a landscape should be stratified before sampling begins, however, depends on several factors. Cochran (1977)
presents the three most common reasons:
1. Stratification may produce a gain in precision of the estimate. If the landscape
is heterogeneous in regard to its snag or tree densities, creating individual
strata, which are homogeneous within themselves, can improve the precision
of an estimate.
2. Sampling problems can differ for different parts of the landscape because of
forest community type, timber harvest method, or seral stage.
3. Resource specialists may want to obtain separate estimates for certain subdivisions of the landscape. For example, if part of a subwatershed is managed
for 40 percent PMP, compared to another, which is managed for 100 percent
PMP, stratification can provide separate estimates for each stratum.
If one or more of the above reasons applies to your situation, it would probably be
beneficial to stratify. The spreadsheets contained within this report can accommodate
up to four strata.
To stratify your survey area, use the following steps:
1. Visit the area if you are unfamiliar with it. Landscape patterns unclear on maps
may become apparent from an initial ground survey. What differences are visible in
the vegetative structure across the landscape? What similarities exist? Begin to
think about strata that are homogeneous in regard to snag and large tree densities
or forest structure.
2. Obtain reference maps for use in the field. Use whatever maps are available. For
example, either geographical information system (GIS), or orthoquad maps, or both,
can contain the following necessary information: (a) current road system with all
detectable roads drawn, (b) stand units and their unique numeric identifier for each
stand, and (c) current seral stage of vegetation. We recommend using maps scaled
to 1:31,680 or less. This information may be contained on one or several maps.
Make several copies of a map with the stand units delineated.

6

3. Obtain the most current aerial photographs of the survey area.
4. Run a query by using either the GIS or any stand exam database available.
Because each local area (district) has its own approach to the storage of stand
data, we recommend first checking with the data specialist to develop the most efficient approach to obtaining this information if you are unfamiliar with its recovery.
You are interested in what each stand supports in regard to (a) the current community type, (b) the management history, (c) seral stage, and (d) snag and large tree
densities. For example, Has the stand ever been harvested? Was regeneration
successful? Has it been thinned? If harvested, what method was used? Were
snags retained? Were large trees retained? Use the aerial photographs to confirm
the database information.
5. Visit the area with the above information.
6. Assign each stand to a stratum. Plan on spending at least one day in the field to
validate the information you have received from the GIS or stand exam database.
Generally, the amount of time spent in the field for stratification purposes will be
directly related to the quality of the information collected from the GIS or stand
exam database. Additional field days may be required to complete the stratification
work. This is case-specific and depends on the resource specialist’s knowledge of
the area.
7. Estimate the number of acres (ha) within each stand or stratum.
We assume that most landscapes surveyed for snags and large trees will have undergone some amount of timber harvest. Consequently, depending on the primary method
of timber harvesting, the placement of each stand unit within a stratum may or may not
be straightforward. For example, on the west side of the central Oregon Cascade Range
where clearcutting has been the primary method of timber harvest, the delineation of
strata for a snag survey should be relatively apparent.
For this situation, combine all unharvested, old-growth stands into a single stratum.
Then consult the silviculturist, and conduct a groundcheck to determine at what age tree
and shrub growth are great enough to interfere with the sightability of snags within the
harvested stands. Separate all harvested stands with overgrown vegetation from those
that remain visually open. These overgrown stands would be your second-growth
stands. Finally, combine all stands that have been harvested more recently where the
line of vision still extends out to at least 66 feet (20 m). This should give you three
strata: (1) recent clearcut stands, (2) second-growth stands, and (3) old-growth stands.
Then generate a map with each stand assigned to one of the three strata for use in
the field.
By contrast, in areas where selective logging has occurred, the designation of individual
strata takes more time, especially where no GIS layers are available. In this situation,
first place stands into strata based on ocular estimation. This can usually be done from
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stationary viewpoints within or near the edge of stands, oftentimes without having to
venture far from roads. For example, in a subwatershed composed of a mix of ponderosa pine and lodgepole pine (Pinus contorta Dougl. ex Loud.) stands, three strata
might be possible, based on various tree composition and varying snag densities: (1)
stands dominated by ponderosa pine with few snags observed; (2) stands represented
by codominance of ponderosa and lodgepole pine trees, with usually one or two snags
per acre observed; and (3) stands dominated by lodgepole pine tree with two or more
snags per acre observed.
Remember, the main criteria in making the decision to stratify a subwatershed are the
sampling objectives. For example, if the sample is designed exclusively for estimating
the density of large trees, the stratification can be dictated solely by this variable. If both
large trees and snags are of interest, stratification should be done based on which of
the two (trees or snags) appears to be more variable. In areas where clearcutting is the
common method of timber harvest, the density of snags and large trees often is highly
correlated, and stratification can be done reliably by using either variable.
The second criterion should be either seral stage or timber harvest technique. Do you
expect that certain stands will be more difficult to survey than others? If so, separate
these out. The final criterion should be forest community. This is especially important for
snags in areas undergoing insect or disease events. Certain tree species are more susceptible to insects or diseases; therefore, where these trees are located, you can expect
higher densities of snags. This may be the situation where lodgepole pine trees intersperse with ponderosa pine.

Methods
General Surveying
Procedures

Field equipment—Surveyors will require some or all of the field equipment in the
list following:
Item
1. Accurate map showing stand units
with stratum number
2. Road map
3. Aerial photographs
4. Orthophoto quads
5. Field data forms
6. Hip-chain
7. Biodegradable hip-chain line
8. Diameter or Biltmore stick
9. Clinometer
10. Compass
11. Meter tape >66 feet (20 m) long
12. Pocket knife
13. Flagging
14. Stake
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Use
Record correct stratum number
Determine location and access
Determine stratum and locations
Determine stratum and locations
Record survey information
Measure transect distances; mark
center line of transect
Same as above
Measure diameter of snags or trees
Measure heights of snags or trees
Determine bearings
Measure perpendicular distances from
the center line
Determine species and decay class
of snags
Mark ends of subsegments, if necessary
Secure end of tape measurer if only
one observer

Field forms—Standardized field forms are provided to record the necessary snag and
large tree information for density and distribution analyses. If both snag and large tree
data are recorded simultaneously, these data should be entered into separate files. All
data entered into the spreadsheet should be numeric, following the format shown on the
sample sheet (fig. 1). If available, hand-held computers can be used for data entry
in the field. The spreadsheets were created with this purpose in mind and data can
be entered directly onto Sheet 1. This eliminates the need to enter the data from the
field forms.
If hand-held computers are not used, however, field forms can be produced by using the
macro Dataform. It will create data forms on a blank worksheet for use in the field.
To create a data form (1) open the Estimate.xls (Estimatm.xls) file; (2) select any blank
sheet in the file (e.g., Sheet 4); (3) select Macro from the Tools menu; (4) highlight
Dataform; (5) choose Run; (6) highlight entire page with mouse; and (7) then choose
Selection, instead of Sheet, under the Print options. This will create data forms with
grid lines (fig. 1).
Establishing Transects

Appendix 2 provides detailed explanations for the correct input of snag and large tree
habitat information. It is also online (filename: Append2.doc) so that it can be customized for different areas; each forest will most likely have different snag and tree
species encountered. Resource specialists also have the option to alter the requirements for each field variable to meet their objectives. For example, should heights
be recorded to the nearest foot or meter? What wildlife signs should be recorded?
Option 1: landscape method—Use the following steps to establish transects by using
the entire landscape: (1) randomly place a grid over the subwatershed map; (2) randomly
select five grid points within each stratum that will be used to establish starting points for
each transect; (3) randomly select compass bearings for each of the five transect starting points; and (4) determine if each of the five transects within each stratum fall within
sufficient area of the stratum to allow four sample subsegments (one subsegment =
164 feet [50 m]) to be placed; if not, select additional transects and starting points until
a total of 20 samples (subsegment lengths), from a minimum of five stands, have been
located within each stratum (fig. 2).
Use a random numbers table for any of the selections above, or generate random numbers using the second hand of a watch. If a watch is used to generate random starting
direction, multiply the number of seconds by six to obtain any of 360 random numbers
that can be used as compass bearings for the starting point.
Option 2: stand method—In areas composed of highly fragmented small stands, it may
be more efficient to dispense with the grid method for establishing transects. For example, some clearcut stands in western Oregon are just large enough to accommodate 654
feet (200 m), or four subsegments of randomly established transect. To establish transects in highly fragmented areas (1) select stands for sampling by randomly picking
stand unit numbers from the complete list of stands within that stratum; (2) select a
random point along the road bordering the stand as an entry point into the stand; and
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Figure 1–Sample data form.
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(3) from the point along the road, randomly select a starting point from which to establish a transect within 164 feet (50 m) of the road. In this way, you can usually sample
at least four subsegments within each clearcut stand.

Figure 2—Example of pilot survey transect establishment on landscape with three strata. A maximum of four
subsegments should be surveyed along each transect within each stand. A minimum of 20 subsegment samples should be taken within each stratum for the pilot survey. Each subsegment is given a unique numeric
identifier (e.g., 1.1, 1.2, 2.1, and 2.2). Two subsegments comprise one segment. Segments are identified by
the whole number associated with the subsegment number.
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The pilot survey should include a minimum of 20 samples taken within each stratum.
For nonstratified landscapes, 20 total samples are needed for the pilot survey.
Subsegment plots are 164 feet (50 m) long. One subsegment is considered one
sample for the pilot survey. Segment plots are 328 feet (100 m) long. Two consecutive
subsegments constitute one segment (fig. 3). The 20 samples should be taken from
at least five different stands for each stratum, or four subsegments (656 feet [200 m])
within each stand (fig. 2). This is necessary to ensure that the variability within each
stratum is adequately represented and will provide a better estimate of the sample size
required for your objectives.
On large subwatersheds, the stands in which the pilot samples are taken should not be
near each other. This is especially important on subwatersheds that encompass several
plant communities because of an elevational gradient. In this situation, divide the subwatershed into three sections and equally divide your samples throughout these sections.
Once the requirements of the pilot survey have been met and the optimal plot size within each stratum has been selected, transects longer than four subsegments in length
(656 feet [200 m]) may be established. Transects within a stand should not exceed 12
subsegment lengths (1,968 feet [600 m]). If the transect crosses through many stands
(and consequently different strata), however, this distance may be increased up to 24
subsegment lengths (3,936 feet [1200 m]) if large samples are required. Use your best
judgment in how long a transect should be to ensure that you adequately sample the
natural variability of the landscape. For landscapes >7,000 acres (2834 ha), it would be
best to continue to establish short transects (four subsegment lengths) after the pilot
survey if your only objective is to compare the estimated density to the targeted density
of snags or trees. See the “Compare to Target Density” section for details.
Plot Size Selection

Presampling selection–In some situations, it may be more practical to preselect a plot
size for sampling, rather than conducting the Optimal Plot Size analysis (see “Optimal
Plot Size” in the “Computer Analysis” section). This can often be determined based on
information gathered during the stratification process. For example, in low-density (<1
snags per acre [0.4 snags per ha]) clearcut strata where travel is easy, a statistical
review of the data reveals little about the optimal plot size. Rather, wider plots should be
used to collect data on as many snags or large trees as possible.
In steep, rugged terrain, or in densely overgrown forest, the wider plots should not be
used because they are inefficient and prone to inaccuracies in these conditions. By contrast, the narrower plots make it easier to detect snags and large trees within the plot
boundaries and to measure their distances. Then, in areas where snag numbers tend to
be low, but clumps of snags are present because of disease or insect events, the
longer, narrower plots work best to minimize the variance. See appendix 3 for additional
information on presampling plot size selection in various forest conditions.
Postsampling selection–In most forested conditions, the optimal plot size to use for
sampling is unknown until a pilot sample has been collected. Then you have estimates of
the density and distribution of the snags or trees in the area. Then use the pilot-sample
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Figure 3—The eight plot sizes available for sampling snags and large trees: two possible lengths and four
possible widths. During the pilot survey, the smallest plot size is nested within the larger plots until an optimal
plot size is selected. Then the optimal plot size is used for the remainder of the survey. The Width33(10) Width132(40) plots refer to the entire width (feet [m]) of the plot. Therefore, only snags or trees whose measured distance from the center line is ≤ half of the width qualify for a specific plot size when determining the
optimal plot size. For example, a snag that is 23 feet (7 m) away from the center line qualifies for the
Width66(20), Width99(30), and Width132(40) plot sizes. It does not qualify, however, for the Width33(10) plot
because its measured distance is not ≤16.5 feet (5m), which is half-width of the Width33(10) plot.
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data to determine which plot size minimizes your sampling effort to obtain your desired
objectives. See the “Optimal Plot Size” analysis section for details. Then the Optimal
plot size can be used for the remainder of the survey.
Snag and Large Tree
Survey Techniques

One of the most critical steps of any snag and large tree survey is to conduct a pilot
survey. The two main objectives in conducting a pilot survey are to (1) collect preliminary data by which to identify the optimal plot size and (2) obtain an estimate of the total
number of samples required to meet your objectives. It is important to recognize that
pilot data are not extraneous data to be discarded. Rather, they are the first samples
collected and to be included in the density and distribution estimates for the entire subwatershed. In areas where snag and large tree densities are high, the pilot survey in
itself may provide an adequate number of samples to meet objectives. By contrast, in
areas where snag and large tree densities are low, analyzing pilot data for the optimal
plot size can greatly reduce the number of samples needed to obtain a desired level of
precision. The optimal plot size can then be used to collect the remainder of the data.
Follow these steps to conduct the pilot survey: (1) use a hip-chain to establish transects;
start transects from the randomly selected points described above, (2) delineate subsegment lengths (164 feet [50 m]) and segment lengths (328 feet [100 m]) along the
transect as you walk, (3) assign a unique numeric identifier to each segment and subsegment as you establish them, and (4) conduct a complete count of all qualifying snags
or trees out to 66 feet (20 m) from the center line. The hip-chain line functions as the
center line. A snag or tree is considered “in” if its midpoint is <66 feet (20 m) from the
center line.
Exceptions to this procedure occur when the stratum to be surveyed has reduced
visibility (<33 feet [10 m]) or high densities (>15 snags or trees per plot are consistently
counted). In these conditions, snags and trees should be counted to 33 feet (10 m)
either side of the center line. See “Presampling Selection” for selecting plot size for
other exceptions to this procedure. After the pilot survey is completed, snags and trees
should be counted to the boundary of the plot size selected rather than 66 feet (20 m)
either side of the center line.
Samples are taken along the transects you have established as described above.
During sampling, it will always be necessary to survey subsegments (164 feet [50 m]) in
sets of two so that combined, they equal one segment (328 feet [100 m]). If at any time
it is not possible to survey two consecutive subsegments, because of stratum changes,
discard the single subsegment plot from the data set. This is critical for the analyses.
Otherwise the spreadsheets will yield erroneous results about optimal transect sizes,
densities, and distributions.
There are four possible widths for both subsegments and segments resulting in a total
of eight possible plot sizes (fig. 3). The four widths available are 33, 66, 99, and 132
feet (10, 20, 30, and 40 m, respectively). These are the whole widths of the plots.
These are referred to as Width33, Width66, Width99, and Width132 plots, respectively,
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in the English version of these spreadsheets. In the metric version, these plots are
referred to as the Width10, Width20, Width30, and Width40 plots, respectively. The half
width of each of these plots is then 16.5, 33, 49.5, and 66 feet (5, 10, 15, and 20 m,
respectively). The half width is the distance out from the center line to which all snags or
trees are counted for each chosen plot width size (fig. 3). All snags and trees should be
measured to their midpoints.
A snag or tree qualifies if it meets stipulated criteria. For each snag or tree encountered,
record the following information: (1) stratum number, (2) segment number, (3) subsegment number, (4) perpendicular distance of the midpoint of the snag or tree in feet (m)
from the center line, (5) species, (6) decay, (snags) or structural (large tree) class, (7)
d.b.h., and (8) height (fig. 1). These fields must be entered for the spreadsheets to operate correctly. Refer to appendix 2 for details about each field variable. The location,
cavity and forage fields are optional. The location field can correspond to (1) the stand
number from which the transect originates, (2) the transect starting position determined
by a global positioning system (GPS), or (3) the Universal Transverse Meridian (UTM)
coordinates of the transect starting point. The Width33(10)-Width132(40) fields are to
be left blank while in the field. These will be automatically filled in by the spreadsheets
during the computer analysis (fig. 1).
Other field variables also may be recorded during surveys. For example, the seral
stage of the stand, distance to the nearest edge, and immediate habitat surrounding a
snag or tree can influence whether it is used by wildlife species. Resource specialists
therefore, may want to include additional habitat variables to measure. Note, however,
that spreadsheet columns to record additional habitat information should be placed at
least four columns to the right of the foraging field before any cavity or foraging analyses occur. Columns “A-S” should not be altered if the macros are to properly operate.
In addition to the field variables listed above, several header row variables must be
filled in for each snag or tree encountered: (1) forest, (2) district, (3) subwatershed,
(4) observer, (5) date, and (6) pages. Because the information recorded for each of
these variables may be the same for each row, data columns are set to the far right of
the data entry spreadsheet. This allows for easy viewing of the data while providing a
permanent record of each of these variables for future referencing. Note that field
names for these header variables begin in column “T.” The columns for these header
rows can be moved.
The numbering system for segments and subsegments is important to follow to maintain
accuracy in all analyses. Each new segment should be given a unique whole number
even if it is a new segment within a different stratum, e.g., 1, 2, 3, etc. Two subsegments are nested within a segment. The subsegments therefore should have the same
whole number as the segment, plus a decimal number indicating whether it is the first
or second subsegment. For example, for Segment 1, there should be a Subsegment
1.1 and a Subsegment 1.2. On each new day in the field, numbering of segments and
subsegments should follow consecutively from the previous day (fig. 2). If several
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groups of observers are conducting surveys simultaneously, however, the numbering
sequence does not have to be consecutive; again, what is important is that each segment and subsegment plot has a unique numeric identifier. For example, if three groups
are surveying on the same day, one group can number plots in the single digits; another
can number plots in the 100 series, and so on.
Of all the fields found on the data sheet, Distance is the most important variable to
record accurately. In cases where no snags or trees are encountered, it is critical to
record a “9999” in the distance column. This allows the macros to distinguish between
plots without snags or trees versus plots that have snags or trees with a distance of “0”
because they are located directly on the center line. Periodically, supervisors should
calibrate measurements of the distance variable to ensure accurate collection of data.
Even small but consistent, overestimation or underestimation of this variable will yield
different results. Attention especially should be given to borderline cases. A borderline
case is one in which the distance of the snag or tree being surveyed falls on the edge
between two width intervals. For example, if a tree is estimated to be 33 feet (10 m)
away from the line, it is important to measure this distance exactly. To record 33 feet
(10 m) when the actual distance is 36 feet (11 m) will bias the accuracy of the data.
We found that we could consistently pace the distance accurately in open, flat areas,
but borderline cases still should be measured. When vegetation or steep terrain make
pacing difficult, distances need to be measured with a tape to maintain accuracy.
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Computer Analysis

In this section, we provide the background, statistics and discussion of each macro
and spreadsheet. Refer to the “Tutorial” section for detailed operating instructions.
Appendix 4 contains frequently used Excel commands. No two data sets will be the
same size, and all macros have been written to accommodate this variation. Data set
lengths will differ depending on the overall densities of qualifying snags and trees, the
number of strata, and the total number of samples taken in a pilot survey.

Data Entry

Users should enter data into the file Estimate.xls (Estimatm.xls). To prepare for data
entry and analysis follow these steps: (1) open the Estimate.xls (Estimatm.xls) file;
(2) rename the Estimate.xls (Estimatm.xls) file with the subwatershed name or another filename; (3) use the newly named file for your own data entry and analysis; this
preserves the file Estimate.xls (Estimatm.xls) in its original format for analysis of other
landscapes; (4) make backup copies of the Tutorial files, Single.xls (Singlem.xls) and
Strate.xls (Stratm.xls); this will preserve the original files for reference and tutorial purposes; (5) enter your data onto Sheet 1; several of the macros need to reference
Sheet 1 to work properly; and (6) double check here to ensure that the number “9999”
has been entered in each subsegment where no snags or trees were encountered;
failing to enter the number “9999” in these rows will cause miscalculations to occur.

Consecutive Plots

Run the macro Consecutive before beginning any computer analysis. It will sort your
data set by segments and subsegments. This is important because data from the same
subsegment plots, entered accidentally or out of sequence, will be analyzed as a separate plot. After running this macro, it is extremely important to scroll through the entire

data set to ensure that two subsegment plots are entered for each segment. For example, segment 13 should contain subsegments 13.1 and 13.2. If segment 13 only has
subsegment 13.1 listed but no subsegment 13.2, this entire segment and subsegment
should be deleted. Otherwise, the analyses for optimal plot size and a distribution index
will be inaccurate.
Formulas

Filling the width columns, Width33(10)-Width132(40), with the appropriate formulas is
the first step performed by the computer analysis. You do not have to write the formulas
in the Width columns yourself. Rather, the macros Formula (Formmulti and Formsingle)
will create the appropriate formulas based on the information you supply in each of four
input boxes. These boxes will appear once the macro has begun running. Refer to the
“Tutorial” section for detailed operating instructions.
There are five criteria for which each snag or large tree is evaluated before a formula is
placed in each of the width columns: (1) d.b.h., (2) height, (3) decay (snags) or structural (trees) class, (4) species, and (5) distance. The first four criteria are relative fields;
the values accepted are those entered by the user. By contrast, the distance criterion is
an absolute field; the macro truncates the distances for each snag or tree in 16.5-foot
(5-m) intervals. Thus, four plot widths are created: 33, 66, 99, and 132 feet (10, 20, 30,
and 40 m, respectively). Again, these four plot widths correspond to the four blank
width columns: (1) Width33(10), (2) Width66(20), (3) Width99(30), and (4) Width132(40),
respectively.
The formulas are “If, then” statements. Therefore, if the snag or tree meets all the
target criteria specified by the user, plus meets the distance requirement, then a “1” is
placed in the column by the macro. By contrast, if the snag or tree fails to meet all the
target criteria, then a “0” is placed in the column. Only those snags or trees that meet
all the requirements of the formula created by the user are given the value “1.”
Consequently, these are the only snags or trees that will be included for the statistical
analysis for each plot size. For example, if the perpendicular distance of a snag from
the center line was measured at 23 feet (7 m), it will qualify in the Width66(20),
Width99(30), and Width132(40) columns if it meets all other criteria. It will not be considered, however, for the Width33(10) column. This is because the Width33(10) column
represents a plot with a 33-foot (10-m) total width, or a 16.5-foot (5-m) half width.
Therefore, only snags or trees <16.5 feet (5 m) away from the center line, in either
direction, will be accepted within the Width33(10) column. See figure 3 for an example.
Two macros are available for entering the formulas for snag analyses. The macro
Formmulti can evaluate several species of snags. It also has the option of excluding a
single species from the analysis. For example, if a manager is interested in the snag
replacement potential provided by large trees, and knows that a species in the area is
not used for nesting purposes, this species may be excluded from the analysis by entering its numeric code when the species input box appears. By contrast, if a manager is
only interested in the density of a single large tree species, the macro Formsingle
allows for this narrowed focus in an analysis. Formsingle is identical to Formmulti (we
refer to both of these as the Formula macros) in every way except that it will evaluate
only a single snag or tree species at a time.
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The Formula macros will evaluate d.b.h. and height characteristics based on a minimum value you provide. By contrast, decay or structural classes are evaluated based
on a maximum value that you want considered for analysis. For example, in the
“Tutorials” provided, decay classes I-III are considered hard snags, and decay classes
IV-V are considered soft snags. This is based on the five-decay class system developed by Cline and others (1980). By entering the number three as the maximum decay
class value, therefore, only hard snags are included in the analysis.
Parks and others (1997) have simplified this system by reducing the number of decay
classes to three. This has been done by combining Cline and other’s (1980) decay
classes II and III together, and classes IV and V together. Both systems are compatible.
The division between hard and soft snags therefore remains the same. We recommend
using the new system developed by Parks and others (1997) for future subwatershed
surveys for its simplicity to new users.
Bull and others (1997) also provide descriptions of large tree structural variations important to wildlife. For example, hollow trees, trees with partial decay, and trees with
brooms provide a valuable wildlife resource. We recommend referring to Bull and others (1997) therefore before beginning a large tree survey to ensure that large tree structural classes are designed to meet your objectives. Refer to appendix 2 for an example.
Large tree numeric values should be arranged so that with increasing values, the tree is
increasingly sound. This is the opposite of the decay class values for snags.
It is important that the width formulas are entered precisely because the macro uses
these columns to calculate the means and standard deviations of the data. When the
Formula macro is finished running, therefore, scroll down throughout each of the width
columns to ensure that they contain an “If, then” statement that looks like the following:
=IF(AND(I2<=16.5, K2<=5, L2>=10, M2>=6, J2<>9999),1,0)

formula 1 (English).

=IF(AND(I2<=5, K2<=5, L2>=25, M2>=1.8, J2<>9999),1,0)

formula 1 (metric).

This is the proper syntax for the formula in the Width33(10) column, for snags <16.5
feet (5 m) away from the line (cell range = I2), in all decay classes (cell range = K2),
with a d.b.h. >10 inch (25 cm [cell range = L2]), height >6 feet (1.8 m [cell range = M2]),
and all species (cell range = J2). If some cells are missing a formula, rerun the macro.
In addition, this macro must be run every time new data are added to the data sheet.
The macro should be run before the strata are separated to avoid having to run it multiple times. Double check that a “9999” is placed in the distance cell whenever a subsegment does not register any snags or trees. This will allow the macro to distinguish
between subsegments with zero snags or trees versus subsegments with a snag or a
tree on the line and a resulting distance of zero feet (m).
The Formula macros can take only maximums and minimums. If, however, you want to
determine the density of snags in a particular size class, these formulas can be edited.
For example, to determine the density of snags that are ≥10 inches (25 cm) d.b.h. and
<12 inches (31 cm) d.b.h., follow these steps: (1) run one of the Formula macros if they
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have not been run already to create the proper syntax (see Formula 1) for the “If, then”
formula; (2) highlight the cell E2; (3) press the function key F2. This will allow you to
edit the formula; (4) insert L2<12 to the “If, then” statement (Formula 2); and (5) press
Enter. This will create the formula:
=IF(AND(I2<5, K2<=5, L2>=10, L2<12, M2>=6, J2<>9999),1,0)

formula 2.

(6) Copy the formula in cell range E2; (7) paste this newly edited formula throughout the
E column; and (8) repeat this procedure for each Width column so that the macro maintains the distance requirement within each Width column. Similarly, if you are interested
in only one decay class of snags, or one structural class of large trees, run one of the
formula macros and edit it to conduct this narrower analysis. For example, if you are
interested in the density of hollow trees within a stratum, and hollow trees are identified
by the numeric code = 1, edit the “K” column in formula 1 shown above to the following:
=IF(AND(I2<=5, K2=1, L2>=10, M2>=6, J2<>9999),1,0)

formula 3.

Next, copy and paste this formula throughout the Width33(10) column. Then repeat this
procedure for all width columns before running further analyses.
Cavity and
Foraging Signs

Depending on the objectives of your snag and large tree surveys, you may want to take
your analysis beyond densities and distributions. For example, if you want to determine
what snag species most of the cavities were found in, use the macro Cavity. Or, if you
are interested in what tree species exhibit the most foraging signs, you can analyze this
situation by using the macro Forage. Each of these macros can evaluate every snag or
large tree for five factors: (1) d.b.h., (2) height, (3) decay (snag) or structural (tree)
class, (4) species, and (5) cavity or foraging use. The main function of both of these
macros is to provide the user with a percent use value. This is calculated by taking the
number of snags or trees with cavities or foraging signs and then dividing this by the
total number of snags or trees encountered:

Pu =

Ss
St – U

,

(1)

where

Pu
Ss
St
U

=
=
=
=

percent use;
number of snags or trees with nesting or foraging signs;
total number of snags or trees encountered; and
unknowns: entire snag or tree could not be examined or unknown whether
foraging or nesting signs were present.

A separate column to the right of the cavity and forage columns is created for these
analyses (labeled “QUALIFYING”). Here you will find the formulas that are created and
placed into the spreadsheet by the macros. These formulas are also “If, then” statements. They evaluate each snag or tree for the target criteria you stipulate. Similar to
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the Formula macros, these macros accept only one value for each input box. These
formulas, however, also can be edited to obtain the precise information on cavities or
foraging you desire. Please refer to the “Cavity” section in “Example I” of the “Tutorial”
for detailed instructions on operating the Cavity macro.
Before conducting any cavity or foraging analyses, check to make sure that no zeros
are found in rows under the Cavity or Forage columns where no snags or trees were
encountered. The value zero is not acceptable here because the macros will view these
as data values in the analysis.
Sorting Data Sets

Few subwatersheds will be homogeneous enough to forgo stratification. In addition, the
optimal plot size likely will differ among heterogeneous strata, as will the means and
variances. Consequently, first separate the strata to analyze each stratum individually.
For nonstratified landscapes, proceed to the “Analysis by Segment” section.
The macro Sort will first sort the data set by stratum in ascending order. Then you will
be prompted to enter the ranges of each stratum. Use the scroll bar to determine the
ranges. Using the mouse to highlight the range will cause the macro to abort. The
macro will place each stratum on a separate sheet. These can be found by clicking on
the tabs labeled Stratum1, Stratum2, etc. If the names of these sheets are not in view,
use the arrows in the bottom left hand corner to tab left, or right, until they appear.
As additional data are collected, they should be entered directly onto Sheet 1 of your
file. Then rerun the Consecutive, Formula, and Sort macros. If for some reason you
have fewer rows of data for a stratum the second time you run the Sort macro, you
should first activate that stratum’s sheet and clear or delete all data on that page. The
macro will then place the correct number of rows of data on the sheet.
When the macro moves the data for each stratum, it takes with it the necessary format
and formulas to conduct all analyses. Simultaneously, it keeps the entire data set in its
original format on Sheet 1.

Analysis by Segment

The macro Segment will compute averages, standard deviations, and sample sizes
based on plot lengths of 328 feet (100 m) or segments for each of the four plot widths.
When initiated, this macro will first sum the number of qualifying snags or trees within
each segment. The macro will then condense the spreadsheet and show only the number of trees or snags within each segment. These will be labeled as Totals but are also
referred to as Subtotals by Excel. We refer to these condensed rows as Subtotals.
After condensing the Subtotals, the macro will move them to a new area. This is necessary or else the macros will calculate averages and standard deviations by using the
original data rows and the Subtotals.
If at any time the Segment macro stops with an error message, restore the sheet to its
original state before running the macro again. To restore the sheet to its original format,
(1) press End within the Error message box if macro stops, (2) highlight all rows below

20

the Grand Total Row, (3) select Delete from the Edit menu, and (4) click on Entire Row.
Then to remove the subtotals, (1) click on the field name SEGMENT, (2) from the Data
menu, select Subtotals, and (3) choose Remove All. With the exception of the first step,
these same steps must be performed whenever a new analysis is run using a different
macro.
There are several ways to determine the range of subtotals to be copied but only one
correct way to enter it into the input box. The proper syntax for a cell range is:
“E2:E213.” The range can be determined either by using the scroll bar or the arrow
keys and visually noting the end cell in the column. If you try to determine the range by
dragging the mouse, the cell range will look like this: =$E$2:$E$213. The “dollar” and
“equal” signs, however, need to be removed or the macro will abort; the macros work on
relative cell ranges to accommodate data sets of different lengths and the “$” refers to
an absolute cell range. If an input box ever blocks the view of the cell ranges, you can
move it by clicking on the title bar and dragging it to a new position.
Once the subtotals have been moved, you will then be prompted to enter the ranges
of each of the newly pasted columns. The macro will then calculate averages and
standard deviations for each segment plot width size:
Averages in Excel Version 5.0 are calculated by using the equation:

x =

∑ xi
n

,

(2)

where
–
x
xi
n

= sample mean,
= value of x observed in sample i, and
= total number of samples.

Excel standard deviations are obtained by the equation:

s =

n ∑x i 2– (∑x i )2
,
n (n –1 )

(3)

where

s

=

sample standard deviation.

The results will be placed both below the condensed rows of information at the cell
address you give, and in the appropriate columns on the Optimal sheet. Always direct
the macro to place the table of results at least three rows below the newly pasted data.
The macro also will provide you with the sample size (N) for this data set. This value is
not, however, automatically transferred to any other spreadsheet. It is good practice to
print out your results before continuing. At the end of this macro, you will be asked if
you want to be transferred to the Optimal sheet. Choosing “No” will keep you on the
active sheet.
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Analysis by
Subsegment

To compute averages and standard deviations for subsegments, use the macro
Subsegment. Operation of this macro is identical to the Segment macro, but sums on
plot lengths of 164 feet (50 m) rather than 328 feet (100 m). To remove the Subtotals,
however, highlight the field name SUBSEGMENT rather than SEGMENT before selecting Subtotals from the Data menu.

Optimal Plot Size

To begin analysis to determine the optimal plot size within a stratum, bring up the
Optimal sheet by clicking on the tab with this label in the lower left screen. Any gray
boxes on this sheet require input from the user. (Note: This sheet could not be protected; please make backup copies in case of accidental entries.) The Stratum box in the
upper left portion of the sheet allows for a written description of the stratum.
This is useful in situations where resource specialists want to determine what the
optimal transect is for both hard snags and large trees. We recommend running the
optimal plot size analysis several times if more than one habitat variable is the focus of
the survey. The Minimum Sample Size Required box just below should contain one of
two numbers, 60 or 20. These numbers correspond to the minimum sample size
required for a simple-random, or stratified-random sampling design, respectively, within
each stratum. See the “Compare to Target” section for an exception to the minimum
sample size required.
There are two options to determine the optimal plot size for a stratum or area. The first
option, the sample size option, examines the number of plots required for sampling in
comparison to the number of acres that would be sampled for the same plot size.
The second option is based on Wiegert’s (1962) method, which incorporates a cost
factor into the analysis. Both methods evaluate the estimated number of samples
needed to obtain a density estimate that is within 20 percent of the true mean,
90 percent of the time.
The sample size option considers three factors: (1) the sample size required in plots
(2) the sample size required in acres (ha), and (3) whether the estimated sample size
(n) meets the minimum requirements. The required sample size is determined by
(Cochran 1977):

n =

tas
d

2

( )

,

(4)

where

n
s
ta
d

=
=
=
=

sample size required to estimate the mean density,
standard deviation of the mean within each plot size,
Student’s t-value for a 90 percent confidence interval (a = 0.10), and
desired absolute error (calculated as 20 percent of the pilot mean).

First look at the number of sample plots required for each size. Then look at the estimated number of acres (ha) required for each specific plot size to obtain the same level
of precision. The optimal plot size is often that which requires the minimal number of
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plots and acres (ha) to be sampled, once the minimum sample size requirements have
been met. Often, several plot sizes will be appropriate. This is where the person who
has conducted the pilot sample needs to examine numbers given on the Optimal sheet
and consider, Would it be more efficient and accurate to use a wider or a narrower plot
width, given the forest conditions of this stratum? For example, the results on the
Optimal sheet may estimate that a Subsegment132(40) plot requires 20 more acres (49
ha) than a Subsegment66(20) plot to obtain the same level of precision. This seems like
a large difference, but what really matters is whether it will take a considerable amount
of extra time to survey to 66 feet (20 m) in a Subsegment132(40) plot, as opposed to
sampling only 33 feet (10 m) out from the line in a Subsegment66(20) plot. In areas
where snags or trees are present in low densities, and visibility is open to 66 feet (20 m)
from the center line, the Subsegment132(40) plots would probably be the best choice.
In contrast, if snag or tree densities are moderate or high, narrower plots are likely the
better choice. This will reduce sampling effort by decreasing the amount of time it takes
to complete each plot. In addition, users need to consider how easy or difficult it is to
see and reach snags or trees out to a specified distance. In steep terrain where shorter
snags may be obscured by vegetation, it is important to select a narrower plot size to
maintain accuracy.
The second option, which incorporates Wiegert’s (1962) method, can aid the decisionmaking process. Wiegert demonstrates that the optimal plot size is that which minimizes the product of the relative cost and the relative variance. Given that you have the
data necessary to determine both relative costs and variances, Wiegert’s method is considered preferable (Krebs 1989). It would be the most accurate to conduct time trials (to
estimate costs) to measure the amount of time it takes to survey each plot size within
your area. Then assuming that costs are directly related to time, relative costs could be
incorporated into the optimal plot analysis. There are, however, some logistical difficulties with conducting time trials because only one plot size can be surveyed at a time. In
addition, time trials cannot be conducted simultaneously while conducting the pilot survey, which requires surveying snags or large trees to 66 feet (20 m) from the center line.
Consequently, the time (and costs) to conduct time trials may quickly offset any benefits
gained by acquiring this information because of the separate field efforts required
beyond the pilot survey.
We therefore recommend that resource specialists not conduct time trials. Rather, we
suggest that if a manager wants to include a cost factor, it is reasonable to use the general costs-per-sample guidelines that we developed. These costs are all built on a relative scale. We have outlined our methods for developing cost estimates, however, so
that resource specialists may understand how the costs were derived. Subsequently,
resource specialists may adjust these costs for their survey areas, or conduct their own
time trials, if they believe their surveys would benefit from the effort.
If resource specialists prefer to incorporate a cost factor into the analysis, six costs per
plot scenarios are listed at the bottom of the Optimal sheet under the General Cost per
Sample Guidelines based on the conditions listed in table 1. These have been made
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available for demonstration. To understand how the relative cost affects the outcome
of your decision about the optimal plot size, pick the category that best describes the
forest situation within the current stratum. Then copy and paste the information within
this column into the Cost per Sample above it. We encourage resource specialists
to try several Cost per Sample categories if their forest conditions fall between the
categories described.
Table 1—Cost estimates based on time trials to conduct snag (>10-inch [25-cm]
d.b.h.) surveys in different forest conditions

Plot dimensions

Time to walk plot
Average
length
number of
( no snags)a
snags per plot

Time per
snaga

Total
timea

Total costb

High visibility (>66 feet [20 m]); easy terrain (<30% slope); low (2 snags/acre [0.8/ha]) density
Subsegment33(10)

2

0.25

2

2.50

0.43

Subsegment66(20)

2

.50

2

3.00

.51

Subsegment99(30)

2

.75

2

3.50

.60

Subsegment132(40)

2

1.00

2

4.00

.68

High visibility (>66 feet [20 m]); easy terrain (<30% slope); high (8 snags/acre [3.2/ha]) density
Subsegment33(10)

2

1.00

2

4.00

.68

Subsegment66(20)

2

2.00

2

6.00

1.02

Subsegment99(30)

2

3.00

2

8.00

1.36

Subsegment132(40)

2

4.00

2

10.00

1.70

Medium visibility (ª16.5 yards [15 m]); moderate terrain (<50% slope); low (2 snags/acre [0.8/ha])
density
Subsegment33(10)

3

.25

3

3.75

.64

Subsegment66(20)

3

.50

3

4.50

.77

Subsegment99(30)

4.5

.75

3

6.75

1.15

Subsegment132(40)

6.75

1.00

3

9.75

1.66

Medium visibility (ª16.5 yards [15 m]); moderate terrain (<50% slope); high (8 snags/acre [3.2/ha])
density
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Subsegment33(10)

3

1.00

3

5.00

.85

Subsegment66(20)

3

2.00

3

8.00

1.36

Subsegment99(30)

4.5

3.00

3

13.50

2.30

Subsegment132(40)

6.75

4.00

3

18.75

3.19

Table 1—Cost estimates based on time trials to conduct snag (>10-inch [25-cm]
d.b.h.) surveys in different forest conditions (continued)

Plot dimensions

Time to walk plot
Average
length
number of
( no snags)a
snags per plot

Time per
snaga

Total
timea

Total costb

Low visibility (<33 feet [10 m]); difficult terrain (>50% slope); low (2 snags/acre [0.8/ha]) density
Subsegment33(10)

6

0.25

4

7.0

1.19

Subsegment66(20)

6

.50

4

8.0

1.36

Subsegment99(30)

24

.75

4

27.0

4.59

Subsegment132(40)

30

1.00

4

34.0

5.78

Low visibility (<33 feet [10 m]); difficult terrain (>50% slope); high (8 snags/acre [3.2/ha]) density
Subsegment33(10)

6

1.00

4

10.0

1.70

Subsegment66(20)

6

2.00

4

14.0

2.38

Subsegment99(30)

24

3.00

4

36.0

6.12

Subsegment132(40)

30

4.00

4

46.0

7.82

a
b

Time in minutes.
Cost calculated at $10 per (hour*person). Units in dollars.

In addition, we have taken Wiegert’s method one step further by calculating the Total
Cost a resource specialist might expect for each plot size selected. We have found this
to be the most valuable piece of information, because all costs are relative to each other
within the same area.The Total Cost also incorporates the Minimum Sample Size
required. Although, the actual cost for sampling may be more or less in a particular
area, selecting the plot size that demonstrates the lowest Total Cost will likely result in
selection of the Optimal plot size for your current forest conditions.
Estimating Costs

The cost per plot, or time, seems to be a function of three factors: (1) visibility, (2) terrain, and (3) density. Visibility refers to the unobstructed viewing distance within a stratum; visibility is most strongly affected by the seral stage, or amount of shrub cover,
within a stand. Terrain includes such things as the slope, shrub cover, and the amount
of downed woody debris. All of these factors affect how easy or difficult it is to walk
through an area. Density is dictated by the target criteria of the snags or trees being
censused and the natural occurrence of these target snags or trees.
Cost estimates per plot were calculated at $10 per observer-hour. In addition to costs
per plot, each survey will have associated fixed cost. Fixed cost is the time spent selecting and locating each beginning transect point and then returning to a vehicle after the
surveying has been completed. This cost can be minimal in clearcut areas or quite high
in areas with difficult terrain. We therefore calculated a fixed cost based on a moderate
situation with a low snag density, which averages the cost per plot in this category for
Subsegments and Segments. This assumes that observers choose the quickest route to
the beginning point of a transect.
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Out cost estimates were based on time trials conducted in forests in northern Idaho
and then adjusted based on cost estimates from a snag study in the central Oregon
Cascade Range. During the time trials, all snags >10 inches (25 cm) d.b.h. were
surveyed. For each, we recorded the following information: (1) species, (2) d.b.h.
(measured by using a Biltmore diameter stick), (3) decay class, (4) height (ocular
estimate), (5) distance of the midpoint of the snag from the center line, (6) nesting
evidence (ocular), and (7) foraging signs (ocular).
In flat, open areas, distances for each snag were either paced or determined by using a
measuring tape. Paced distances were accepted only after accuracy and consistency in
the estimation of distances of snags not considered to be marginal could be demonstrated. A snag was considered marginal, for example, if its distance of 16.5 or 18 feet
(5 or 5.5 m) away from the line was uncertain. For these cases, all distances were
measured. In addition, periodic calibration of pacing was conducted. In steep areas,
all distances >12 feet (3.5 m) were measured.
We developed six hypothetical situations based on our experience surveying snags.
“Easy” refers to an area that is relatively flat (<30 percent slope) and where snags or
trees are easily observed out to 66 feet (20 m) in both directions. “Moderate” refers to
situations where the slope is <50 percent and visibility of snags or trees averages 50
feet (15 m). “Difficult” describes situations in which a combination of factors makes
travel difficult and slow, and visibility is low. For example, in dense regeneration stands,
it is not possible to accurately detect snags beyond a particular distance. Travel could
be difficult as a result of slope (>50 percent), type of seral stage, or the amount of shrub
cover or downed woody debris. Cost estimates were developed for each forest situation
given two densities: (1) two snags per acre (0.8 snags per ha) and (2) eight snags per
acre (3.2 snags per ha) as shown in table 1.
To develop the costs, we first determined the average amount of time required for an
observer to walk a 164-foot (50-m) line looking for snags in the various forest conditions
but without encountering any target snags. Then we estimated the average amount of
time per snag in the different forest conditions required to record the snag characteristics listed above. Next we summed the time required to walk a transect without snags,
with the time per snag given the two densities. Total time was then multiplied by $10
per hour to obtain the cost (table 1). Costs for all Segment plots were derived by simply
doubling the cost of a Subsegment plot with the same width.
Within the moderate and difficult categories, costs jump considerably for the
Width99(30) and Width132(40) plot sizes. This is a result of the observer having
to periodically leave the center line to survey beyond the point of visibility.
Sample Size
Determination
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For unstratified subwatersheds, the estimated sample size is given on the optimal sheet
under “Sample Size (plots).” For stratified subwatersheds, go to the sheet Sample Size.
This sheet provides two methods for estimating the total sample size required on a
stratified subwatershed: (1) optimal and (2) proportional allocation. It also breaks down
the total sample size required into the number of plots required for sampling within
each stratum.

Proportional allocation of the sample size allocates the samples among the strata based
on the proportion of the total area in each stratum (weight Wi). In contrast, optimal allocation incorporates both the stratum proportional area (Wi ) and variance (si 2 ) to determine how many samples are required within each stratum (Krebs 1989). Both methods
calculate the number of samples required to obtain a density estimate that is within 20
percent of the true mean, 90 percent of the time.
The sample size (Krebs 1989) required by the proportional allocation method is determined by the equation:

n=

ta2 ∑ Wisi 2
,
B2

(5)

Then the number of samples within each stratum (ni) is determined by multiplying the
total number of samples needed (n) by the weight (Wi) of each stratum.

ni = nWi ,

(6)

Sample size for the optimal allocation method (Krebs 1989) is found by the following
equation:

n=

(∑Wisi )2
,
B
1
2
+
(∑Wisi )
ta
A
2

( )()

(7)

Then the number of samples needed within each stratum is estimated by:

ni = n

(

Aisi
∑Aisi

)

,

(8)

where

B
ta
n
Wi
si
s2i
A
Ai
ni

=
=
=
=
=
=
=
=
=

desired bound for 1 - a (xst * 20 percent),4
Student’s t -value for 90 percent confidence limits (1 - a),
total sample size required in stratified sampling,
stratum weight (Ai /A),
standard deviation in stratum i,
variance in stratum i,
total number of acres (ha) in subwatershed,
number of acres (ha) in stratum I, and
total sample size required in stratum i.

4

We have substituted the symbol B (to denote bound)
for the d listed in Krebs’ (1989) equations.
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There are advantages and disadvantages to each of the allocation methods.
Proportional allocation offers the advantage of dropping the strata and combining all
samples after the sampling is done. You would do this in cases where you found little
or no difference in densities between strata. This will yield both a larger sample size
(n) and a smaller variance (s2). By contrast, this option is not available if the optimal
allocation method is used. The optimal allocation method, however, provides the best
estimate for the least cost in situations where large differences in density exist between
strata. With this method, sampling is concentrated in the stratum that has the highest
variance. By contrast, proportional allocation concentrates sampling effort in the largest
stratum, regardless of the variance within each stratum.
It is important to remember that the sample sizes given are only estimates of the number required to obtain a desired level of precision. Consequently, we recommend that
data be analyzed in the macros periodically to gauge the precision of estimates.
Estimating Densities

After a minimum of 60 samples (See the “Establishing Transects” section for an exception to the minimum number of samples required.) have been collected (or 20 samples
per stratum), the mean density of snags or trees can be estimated; resource specialists
may then decide whether enough samples have been collected to achieve their objectives. The two density options provided are (1) Estimate Average Density and (2)
Compare to Target Density. These allow the user to either obtain an average snag or
tree density that is within 20 percent of the true mean at a desired confidence level or
determine whether the estimated density is significantly different from the targeted density, respectively. Users can choose both options. For the Estimate Average Density
option, use the Densities sheet. For the Compare to Target Density option, you must
first obtain a density estimate from the Densities sheet, and then use this information on
the Statistical Test sheet.
Estimate average density—To meet the requirements of the Estimate Average Density
option, two equations are available on the Density sheet based on two sampling methods: (1) simple and (2) stratified random sampling. For the simple random sampling
method, the average is calculated in the normal way (equation 1). Then the variance is
calculated by:
∑(xi – x )2
,
(9)
s2 =
n–1
and the standard error of the mean is then determined by:

sx =
where

x
xi
n
s2
sx
ta
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=
=
=
=
=
=

s2
,
n

population mean,
observed x value in sample i,
sample size,
variance of the measurements,
standard error of the mean x , and
Student’s t-value for 90 percent confidence limits (1 - a ).

(10)

The confidence interval is then calculated by using a normal approximation
(Krebs 1989) :
x ±tasx ,

(11)

As in the previous sheets, all shaded boxes require input from the user. The t-value is
preset at 1.67 for a sample size equal to 60 to obtain a 90-percent confidence interval.
If a different level of confidence is desired, however, the t-value may be changed. In the
first section of the Densities sheet, an estimated mean is given based on simple random
sampling methods.
In the second section, a density estimate with a bound is calculated based on stratified
random sampling methods. The stratified mean density is computed by the following
equation:
L
∑ Ax
(12)
x st = i =1 i i ,
A
To calculate a confidence interval, the stratified variance must first be determined:
L

Variance of (x st) = ∑

i =1

(

Wi 2 si 2
ni

)

,

(13)

Then the confidence interval is calculated by the normal approximation:

x st ± ta

(

)

var(x st) ,

(14)

where

x st
xi
Ai
A
ni
i
L
si 2
Wi

=
=
=
=
=
=
=
=
=

stratified population mean (number per acres [ha]),
observed mean in stratum i,
number of acres (ha) in stratum i,
total number of acres (ha) in subwatershed,
number of samples in stratum i,
stratum number,
number of strata,
variance in stratum i, and
stratum weight or proportion of area in stratum i (Ai /A).

Because this section is designed to accommodate landscapes with different numbers
of strata, the user must enter the correct number of strata in the column Stratum Number. The macro counts the number of rows within this column that contain a value corresponding to the number of strata within the landscape. It then selects the appropriate
equation for the given number of strata. For example, for a subwatershed with four strata, enter the numbers 1, 2, 3, and 4 in each of the rows under the column heading
Stratum Number.
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Compare to target density test—The second density option is an informal statistical
test that allows resource specialists to determine whether the estimated snag or tree
density is significantly different from the targeted density identified as part of their standards and guidelines. A minimum of 60 samples for the landscape, or 20 samples from
each stratum (whichever is higher), are required. For subwatersheds >7,000 acres
(2834 ha) increasing your sampling effort may be necessary to compensate for the
natural variability of snags and trees because of an elevational gradient. For example,
a 20,000-acre (8097-ha) subwatershed, which encompasses three distinct forest community types, may require about 100 samples to adequately conduct the Compare
to Target Density test. This translates into an increase of about three sample plots
for every 1,000 acres (405 ha) surveyed above 7,000 acres (2834 ha). See the
“Establishing Transects” section for details in plot establishment. This option is especially useful in situations where densities are low and the sampling effort to obtain an
estimate within 20 percent of the true mean (90 percent of the time) is extremely high.
It is intended for surveys where the main objective is determining whether the subwatershed meets the targeted guidelines for snags or large trees. Note here that
recent data suggest that snag targets set in National Forest plans are too low (Bull
and others 1997).
The most common way to test for a significant difference between two means is to conduct a t-test that compares the mean within each plot to the target mean. Although this
would work for our purposes, in single-stratum landscapes, there are some problems
with this approach on stratified landscapes. Consequently, we chose to use the confidence interval statistical test. This test determines whether the targeted density value
falls within the confidence interval of the estimated density. Because the bound on the
density estimate is calculated by using a t-statistic, it is essentially the same as a t-test.
This t-statistic has the same distribution as the Student’s t-test statistic. In addition, this
approach simplified the process and made it possible to use with stratified landscapes.
Resource specialists can use this same statistical comparison after the minimum number of samples has been met. The spreadsheet labeled Statistical Test then allows
resource specialists to visually assess whether the estimated and targeted densities
of a survey are significantly different from each other (fig. 4). Users need only enter the
targeted density and the estimated density and its bounds from snag or tree survey; the
resulting graph is automatically plotted. For example, on a homogeneous 6,044-acre
(2447-ha) study site in ponderosa pine forest in the Oregon Cascade Range, one objective was to determine whether the study area met the targeted hard snag densities listed
in the Forest plan. The Forest plan guidelines (Deschutes National Forest plan 1992;
see footnote 1) for this area stipulated it support at least 0.9 hard snags per acre (2.2
hard snags per ha). On this site, the estimated (n = 175) hard snag density was 0.11 +
0.04 snags per acre (0.3 + 0.1 snags per ha [Bate 1995]). It was obvious that the study
area did not meet the targeted snag densities listed in the Forest plan; this could be
demonstrated statistically. The null hypothesis for this test was:
Ho: There is no difference between the targeted and estimated hard snag densities.
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1.00
0.90
0.80

Numbers per acre

Numbers per acre

0.70
0.60
0.50
0.40
Target density

0.30

Estimated density

0.20

Upper limit

0.10

Lower limit
0.00
90
Confidence interval
Figure 4—Statistical Test sheet. Results of the statistical test found a difference between the targeted density
of 0.9 snags per acre (2.2 snags per ha) and the estimated density of 0.11 snags per acre (0.3 snags per ha).
Data from intensively harvested landscape in ponderosa pine forest on the Deschutes National Forest.

To evaluate the results, we checked whether the target value (0.9 hard snags per acre
[2.2 snags per ha]), fell between the values 0.07 and 0.15. These values are the upper
and lower limits on the density estimate 0.11 hard snags per acre (0.27 hard snags per
ha). If so, we could fail to reject the null hypothesis. In this case, however, the targeted
density did not fall within the confidence interval of the estimate (fig. 4). We therefore
rejected the null hypothesis. These are the results when a 90 percent confidence interval is used. If there is any uncertainty at the 90 percent confidence level as to whether
there is a difference between the targeted and estimated densities, resource specialists
may select a narrower confidence interval to decrease the possibility of a type I error.
If after this step, a manager still questions the results, more samples should be taken
before repeating this test. By contrast, resource specialists should be aware that the
biological consequences of having a type II error occur may be more serious. We therefore recommend consulting with a statistician so that you are aware of the biological
consequences of each of these types of errors before implementing any major management actions as a result of this test.
Distribution Analysis

The Distribution Index sheet estimates how evenly distributed target snags or large
trees are across a landscape; this is based on the percentage of the sampled landscape
supporting target snags or large trees. To obtain a distribution index, users must first
obtain two values: (1) present value and (2) count value. These are calculated by using
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the macro Pres_Abs. These values are the number of Segment33(10) plots supporting
a target snag or tree, and the total number of plots sampled, respectively. These values
are then entered onto the Distribution Index sheet. The macro Pres_Abs runs similarly
to the Segment and Subsegment macros in that it will sum the number of target snags
or trees within each row. It will only do this, however, for the Width33(10) column. It will
then condense the information into rows of Subtotals. Next, the condensed Subtotals
will be pasted to another area for analysis. As with the Segment macro, it is necessary
to enter the range by using the following format:
C1:F334
Symbols within the range will cause the macro to abort.
For single stratum landscapes, use the first section on this sheet. For stratified subwatersheds, use the second section and run the macro Pres_Abs on each stratum.
In addition, you will need to know the total number of acres (ha) within each stratum.
Subsequently, a stratified distribution index is produced. Follow the directions given
in the “Tutorial” for complete details about proper cell entries.
While calculating a stratified Distribution Index, it is critical to enter the correct number
of strata by deleting the empty cells. This is similar to the Densities sheet where the
equation used is driven by the numbers in the Stratum column. Otherwise, the macro
selects the wrong equation. Highlight the unused stratum cells under Stratum and
press Delete.
As the name of the macro Pres_Abs suggests, the Distribution Index is a presenceabsence analysis. It determines the proportion of plots with a qualifying snag or tree,
divided by the total number of plots sampled. The proportion of plots containing a qualifying snag or tree is then adjusted to compensate for the small amount of area sampled
relative to the critical area of 10 acres (4 ha). This result can then be extrapolated
across the entire landscape.
We chose 10 acres (4 ha) as the critical area to evaluate for the distribution analysis,
because it approximates the average home range size of the red-breasted nuthatch
(Sitta canadensis) (Raphael and White 1986). This primary cavity-nester has the smallest home range of the primary cavity-nesters. In addition, 10 acres (4 ha) is often
recommended as an appropriate size area on which to evaluate the distribution of
snags for cavity-nesters (Raphael 1997). In choosing this size area, we assume that
if snags and large trees are adequately distributed to meet the needs of red-breasted
nuthatches, this distribution will also meet the needs of cavity-nesters that have larger
home ranges.
We theorized that if snags are adequately distributed on a landscape, we should find a
hard snag present within nearly every 10-acre (4-ha) circular area. To test our theory, we
used snag data collected from three old-growth strata in the central Oregon Cascade
Range (Bate 1995). Then we approximated the diameter of an area of this size by joining
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two Segments (656 feet [200 m]) together. The diameter of a 10-acre (4-ha) circle is
738 feet (225 m). Combined with a 66-foot (20-m) width we were sampling about 10
percent of a 10-acre (4-ha) area. In the two old-growth stands of Douglas-fir/western
hemlock forests, target snags (>18 inch [46 cm] d.b.h., >20 foot [6 m] height, decay
classes I-III [Cline and others 1980]) were present in an average of 88 percent of these
two Segment66(20) plots joined together. On a landscape with old-growth ponderosa
pine forest present, we found that 90 percent of these double Segment66(20) plots had
a target snag (>10 inch [25 cm] d.b.h., >6-foot [1.8-m] height, decay classes I-III [Cline
and others 1980]) present. When all decay classes were included, the proportion
increased to nearly 100 percent in both forest types. We then used these results as
the baseline from which the proportions from smaller plot sizes were adjusted.
We wanted to conduct the distribution analyses by using the narrowest plot size (33 feet
[10 m]) so that a distribution index could be calculated regardless of the optimal plot
size selected for density analyses. We also wanted to avoid having to collect information with plots 656 feet (200 m) in length. To do this, we looked at the relation between
the proportion of larger plots with a snag present compared to the proportion of the
smaller plots with a snag present (1 minus proportion of plots with snags absent).
We then used a fractal dimension to adjust for the change in the proportions because of
the change in the scale (Milne 1991). The proportions found in each of the plot sizes
are related by:

Pabs = pn ,

(15)

where

Pabs = proportion of larger plots with snag or tree absent,
p
= proportion of smaller plots with snag or tree absent, and
n
= fractal dimension.
Next, we calculated the value “1 - p ” (proportion of plots with a target snag present) by
using the old-growth sites described above. We used this as a baseline value. Then
we divided the proportion of smaller plot sizes supporting a target snag for sites in
various conditions: lightly, moderately, and intensively harvested. This gave us what
we termed the Distribution Index. We found that old-growth areas had an index of 1.00
or greater. This translated into about 90 percent of the larger plot sizes supporting a
hard target snag. In contrast, intensively harvested areas, where large areas were
devoid of snags, had a Distribution Index of 0.40 or less. Given that woodpeckers are
territorial, we questioned the level at which these areas could support breeding populations of woodpeckers. Realize that the Distribution Index for both hard and soft snags
would be higher.
The need for a Distribution Index became apparent after a study done on a subwatershed in the Willamette National Forest found that only about 28 percent of the landscape supported any qualifying snags (Bate 1995). This subwatershed had a stratified
Distribution Index of 0.39. Although clearcut and second-growth areas did have some
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large, soft remnant snags and smaller diameter hard snags, most snags that met the
target criteria were encountered only in the remaining old-growth forest. In a situation
like this, the stratified snag density becomes irrelevant because of the poor distribution
of snags.

Tutorials
Example I: Density and
Distribution Analysis
for Single-Stratum
Landscape

Background information—You are the manager of a stand of old-growth ponderosa
pine located on the east side of the central Oregon Cascade Range. The entire oldgrowth area comprises 900 acres (364 ha). You need to estimate the density of hard
snags to determine whether the area meets the targeted densities listed in the Forest
plan. Only hard snags (decay classes I-III [Cline and others 1980]) that are ≥10 inch
(25 cm) d.b.h. and ≥6 feet (1.8 m) tall qualify. You are also interested, however, in determining the density of soft snags in this same size class to provide baseline data
for resource specialists in adjacent areas. They are interested in mimicking old-growth
characteristics in this region. You therefore plan on sampling all decay classes but with
hard snags as the primary objective. In addition, you want to assess how evenly qualifying hard snags are distributed across the landscape. Finally, you would like to obtain
some information on the percentage of snags that are used for nesting.
Stratification—To start the snag surveying project you use aerial photographs and
stand maps to determine whether any apparent strata can be delineated. The area
appears patchy in regards to the seral stage because of management actions; some
areas have undergone controlled burns, whereas others have not. You think therefore
that this may mean very different snag densities. A more thorough ground check, however, reveals a relatively homogeneous forest in regard to snag densities based on
1-acre (0.4-ha) ocular estimates. Consequently, the area was not stratified. Visibility
averages about 49 feet (15 m), and the area is flat and easy to traverse.
Pilot survey—Five transects were established within the area. Placement was determined by randomly placing a grid over a map and then randomly selecting five grid
intersection points for the starting point of each transect. The compass direction was
then also chosen randomly. Each transect was delineated into two segments or four
subsegments. Two consecutive subsegments constitute one segment. A hip-chain was
used to delineate each 164-foot (50-m) subsegment plot.
Field forms were created by using the macro Dataform (fig. 1) to record all information
gathered in the field. (See “Field Forms” under “General Surveying Procedures” for complete details.) To explain to observers what information was required under each field
heading, you customized the file called Append2.doc. This file contains the basic field
descriptions and the numeric codes for each habitat variable.
Once in the field, all qualifying snags within each subsegment were counted out to 66
feet (20 m) from the center line. Snags were measured to their midpoints. The d.b.h.
and height of each snag were measured. Diameters were measured in inches (cm) and
heights in feet (m). In addition, for each snag encountered, you recorded the perpendicular distance of the midpoint of the snag in feet (m) away from the center line, the
numeric code for species, its decay class (Cline and others 1980), and the numeric
code to indicate evidence of nesting or foraging.
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Data entry—To enter your own data, you open the file Estimate.xls (Estimatm.xls) and
go to Sheet1. For this example, however, the data are already entered and can be
found in the file Single.xls (Singlem.xls). Open this file in the spreadsheet program Excel
for Windows, Version 5.0. On Sheet 1 you will find the data from the pilot survey
described above. Twenty subsegments, nested within 10 segments, of data have been
entered. Note that the data have been entered into the spreadsheet following the same
format provided on the field form and are always entered on Sheet 1 (fig. 1). If these
were your own data, you would need to run the macro Consecutive before beginning
computer analyses. For this example, it is not necessary. Please refer to the
“Computer Analysis” section for information on this macro.
You now want to run the analyses to determine which of the eight available plot sizes
minimizes your sampling effort for snags that meet the target criteria. However, you
have two objectives: (1) hard snag density and (2) the density for snags in all decay
classes. First, run the analysis on qualifying hard snags. The first step is to run the
Formula macros.
Formula entry—The first step in the computer analysis is to place the appropriate formulas within each of the Width columns. This is done by the macro Formmulti using
the distances you recorded in the field. To activate the macro, (1) click on Macro from
the Tools menu, (2) highlight Formmulti, and (3) press Run.
To create the correct formula for each of the Width columns follow these steps: (1)
When an input box appears with the message, “Please enter the minimum d.b.h. you
want to consider for this analysis,” enter the number 10 (25). This is because target
snags are ≥10 inch (25 cm) d.b.h. For the metric version, the correct entry is in the
parentheses: (2) Then press the OK button when a message box appears to confirm
that this is the correct value; (3) When the height input box appears, enter 6 (1.8) to
specify that only snags with heights ≥6 feet (1.8 m) tall should be considered; (4) Press
OK after the message box appears to confirm your entry; (5) For the Class input box,
enter “3.” This is based on the decay class descriptions of Cline and others (1980),
where hard snags were those in the Decay Classes I-III; and (6) Finally, when the
macro asks if you want to exclude any species from the analysis, enter “9999” to
specify that you want all species of snags to be considered in the analysis.
To have these formulas entered throughout the Width columns, (1) enter E2:E50 for the
range of the Width33(10) column. Use the scroll bar on the right side of the screen to
determine the last cell row in the Width33(10) column; then (2) enter F2:F50, G2:G50,
and H2:H50 for the ranges of the Width66(20), Width99(30), and Width132(40) columns,
respectively; and (3) check to ensure that each row in the width columns contains either
a “0” or a “1.”
Analyzing by segment for single stratum—The next step is to calculate averages and
standard deviations for each plot size. The macro Segment will do part of this; first, it
will sum the total number of qualifying snags within the segment plot sizes that are
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328 feet (100 m) in length. To obtain these statistics, follow these steps: (1) select
Macro from the Tools menu; (2) highlight the Segment macro; (3) press Run. You will
see the macro create rows of Totals. Excel refers to these as Subtotals; for clarity, we
also refer to these as Subtotal rows. Then the spreadsheet is condensed so that only
the Subtotals are shown.
The next step is to move only the visible Subtotals rows to a new area for analysis.
Otherwise, the macro will calculate averages and standard deviations on both the individual data rows and the Subtotal rows. To transfer these Subtotal rows, (1) enter
C1:H60, when an input box appears with the message “Please enter the range which
includes the Segment and Width columns, but excludes the Grand Total row (C1:H?).”
If the input box interferes with the range determination, just click on the title bar Copy
Range and drag it out of the way. Then use the scroll bar to determine the range. Do
not use the mouse because it will include absolute range symbols in the value, which
will cause the macro to abort. Refer to the directions given below to restore the sheet
back to its original format if an error occurs. (2) Then a message box will appear to verify that the range you entered is correct; click OK, and then Yes if the range is accurate.
If not, click No and a second input box will appear for the correct range; and (3) enter
the cell range C64 for the input box labeled Paste Range. The table of results should
always be at least three rows below the newly pasted data.
The next steps will build the table of SEGMENT Results and place it below the newly
pasted data. To do this, (1) enter the cell range E65:E74 when asked for the “range of
the newly pasted Width33(10) column”; (2) direct the macro to place the table at the cell
range E77 by entering this value into the input box labeled Segment Results. Here is
where the macro will insert the averages, standard deviations, and sample size into a
table for the various widths of the segment plots; and (3) enter the ranges of the newly
pasted Width66(20), Width99(30), and Width132(40) columns. The correct ranges for
this sample data set are F65:F74, G65:G74, and H65:H74, respectively. After the
ranges have been entered a message box will appear with each value you have given.
Click OK or enter to proceed.
Finally, the macro presents you with another input box: "Do you want to switch to the
Optimal sheet to see your results? Please record your current results for use in further
analyses. Remember, to analyze by Subsegment, you must first restore the data set to
its original format." Click on No. This will keep you on Sheet 1. Now scroll down below
the newly pasted Subtotals. There you will find a table with the segment averages,
standard deviations, and number of samples for this data set (table 2). The row labeled
Segment33(10) gives you the average snag density and standard deviation for plots that
are 328 feet (100 m) long by 33 feet (10 m) wide. Segment66(20), Segment99(30),
and Segment132(40) rows refer to plots that are also 328 feet (100 m) long, but either
66 feet (20 m), 99 feet (30 m), or 132 feet (40 m) wide, respectively. These results are
based on the pilot sample of 20 samples. The “N” is “10,” however, because the macro
lumped two consecutive subsegments together to determine whether longer plots would
be more efficient than shorter (164-feet [50-m]) plots. The averages and standard
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Table 2—Segment plot statisticsa

Plot dimensions

Average

Standard
deviation

Segment33(10)

0.8

0.789

Segment66(20)

1.8

1.874

Segment99(30)

2.4

3.098

Segment132(40)

2.8

3.615

N

10

a Averages and standard deviations for each segment plot size, along with total sample size, using
the Single.xls (Singlem.xls) data set. Values calculated by the macro Segment. Analysis for hard
snags from old-growth ponderosa pine landscape.

deviations from this analysis also will be placed in the appropriate cells on the Optimal
sheet for analysis. You may want to print these results for your own records. To print
the results, (1) highlight the range with the mouse by clicking and dragging; (2) select
Print from the File menu; and (3) Choose Selection. Also note that the “N” is not
recorded elsewhere.
After recording or printing the results of this analysis, you need to restore Sheet 1 back
to its original format so that you can run an analysis based on Subsegment plots.
To restore the sheet to its original format, (1) select all rows containing data beneath
the Grand Total row, (2) select Delete from the Edit menu, (3) press on Entire Row,
(4) activate the cell with the field name SEGMENT, (5) choose Subtotals from the Data
menu, and (6) select Remove All. This will return the data set to its original format.
If the macro ever stops because of a cell range entered incorrectly, you will receive
an error message box. Click End within the message box and proceed with the steps
listed above to restore the sheet to its original format.
Analyzing by subsegment for single stratum—The next step is to estimate the averages and standard deviations for the subsegment plot sizes that are 164 feet (50 m)
long. Refer to the directions given above to restore the sheet to its original format, if
Subtotals or results remain from any other analyses. To start the Subsegment macro,
(1) select Macro from the Tools menu, (2) highlight Subsegment, and (3) press Run.
Similar to the Segment macro, the macro will first sum the number of qualifying snags
in each plot and then present these results in condensed Subtotal rows.
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The next steps involve transferring the Subtotals to a new area for analysis. Enter
D1:H70 into the input box titled Copy Range. A message box will appear with this range
value. If correct, click on Yes. If not, click No and a second input box requesting the
same range will appear and you can enter it correctly this time. Enter D73 into the input
box titled Paste Range. This is where the Subtotals will be pasted.
To have the macro create the Subsegment statistics table, (1) enter E74:E93 into the
input box labeled Width33(10) Statistics; (2) enter the value E96 into the input box titled
SUBSEGMENT Results. The Subsegment Statistics table will be placed here; and (3)
enter the ranges of each of the newly pasted Width66(20), Width99(30), and
Width132(40) columns when you are prompted. The correct entries for these input
boxes are F74:F93, G74:G93, and H74:H93, respectively.
Finally, the macro will bring up an input box with "Do you want to switch to the Optimal
sheet to see your results? Please record your current results for use in further analyses.
Remember, to analyze by Segment you must first restore the data set to its original format." Choose Yes. This will transfer you to the Optimal sheet. On Sheet 1 below the
newly pasted data, however, you will still find a table of Subsegment results. Table 3
shows the correct averages and standard deviations for each of the 164-foot (50-m)
subsegment plots. For example, Subsegment33(10) refers to a plot that is 164 feet (50
m) long by 33 feet (10 m) and its estimated average and standard deviation for the 20
pilot samples. In addition, the table gives you “N” which is the number of subsegments
for this data set.
Table 3—Subsegment plot statisticsa

Average

Standard
deviation

Subsegment33(10)

0.4

0.681

Subsegment66(20)

.9

1.21

Subsegment99(30)

1.2

1.795

Subsegment132(40)

1.4

2.01

Plot dimensions

N

20

a Averages and standard deviations for each subsegment
plot size, along with total sample size, using the Single.xls
(Singlem.xls) data set. Values calculated by the macro
Subsegment. Analysis for hard snags from old-growth
ponderosa pine landscape.
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Optimal plot size—The next step is to determine which plot size optimizes sampling in
the current forest conditions. This is done on the Optimal sheet. (If you chose not to be
transferred to the Optimal sheet after running the Subsegment analysis, you can switch
to it now by clicking on the Optimal tab in the lower left hand corner of the screen.)
The shaded boxes on this sheet are those requiring input from you. First, write a brief
description of the study area in the shaded box labeled Stratum. For example, for this
analysis you might write:
“Stratum: Old-growth P.Pine; ≥10 in (25 cm) d.b.h.; ≥6 ft (1.8 m) tall; Hard snags.”
Then look under the column heading Mean Density (no. per plot). Here you will find the
estimated average for each of the eight plot sizes. These values were automatically
transferred when you ran the Segment and Subsegment macros. Similarly, you will find
the appropriate standard deviation values under the column heading Standard Deviation
(no. per plot). Table 4 shows the correct entries and resulting calculations.
In the first section of the Optimal sheet, you will find that the Mean Density (no. per plot)
has been converted to the number of snags per acre (ha) under the column heading
Mean Density (no. per acre [no. per ha]). Similarly, the standard deviation of each plot
has been squared to get the variance, and then converted to the no. per acre (no. per ha)
under the Variance column. Then, beneath the Variance column you will find a value
with the label Lowest Variance = 10.08 (62.22). The Optimal spreadsheet uses the lowest variance calculated among the eight plot sizes as the divisor for all the variances.
These values are used to calculate the relative variances; they are then used to fill the
Relative Variance column. The next two columns of this section, Sample Size (plots),
Sample Size (acres [ha]), calculate the total number of plots and acres (ha), respectively, needed to obtain a density estimate that is within 20 percent of the true mean 90 percent of the time. Finally, the last column, Number of Acres (ha) Required, gives the minimum number of acres (ha) required for sampling (table 4). This value includes the pilot
sample data. This is based on the value entered into the cell labeled “Minimum Sample
Size Required.” For a single stratum landscape, a minimum of 60 samples are required.
For landscapes with two or more strata, the minimum sample size within each stratum is
20. See the “Establishing Transects” section for exceptions to the minimum number of
samples required. For this data set, enter “60” into the box labeled “Minimum Sample
Size Required” in the upper left corner of the sheet.
To select the optimal plot size, first look at the number of plots required for each plot
size. Which plot sizes require the smallest number of samples? Then consider the plot
size in terms of area (acres or ha). Segment33(10) plots require both the lowest number of plots (68) and acres (17) to be sampled. (For the metric version, 6.8 ha are
required.) It is important, however, to remember that a minimum of 60 samples are
required for these methods regardless of the plot size used.
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16,236 (1500)
21,648 (2000)
10,824 (1000)
21,648 (2000)
32,472 (3000)
43,296 (4000)

Subsegment99(30)

Subsegment132(40)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(4)

10,824 (1000)
16,236 (1500)
21,648 (2000)
10,824 (1000)
21,648 (2000)
32,472 (3000)
43,296 (4000)

Subsegment66(20)

Subsegment99(30)

Subsegment132(40)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(40)

1.31

1.71

1.41

1

1.62

2.3

2.35

2.98

Relative
variance

2.8

2.4

1.8

.8

1.4

1.2

.9

0.4

2.11

2.11

2.11

2.11

1.06

1.06

1.06

1.06

Fixed
cost

3.615

3.098

1.874

.789

2.01

1.795

1.21

0.681

Variance

2.82 (7)

3.22 (8)

3.62 (9)

3.22 (8)

2.82 (7)

3.22 (8)

3.62 (9)

3.22 (8)

5.4
1.70

Lowest total cost

4.4

3.7

3.4

2.7

2.2

1.8

1.7

Total cost
per plot
unit

3.32

2.30

1.54

1.28

1.66

1.15

.77

.64

Dollars

Cost per
sample

10.08 (62.22)

13.2 (81.7)

17.3 (106.7)

14.2 (87.8)

10.1 (62.2)

16.4 (101.1)

23.2 (143.2)

23.7 (146.3)

30 (185.3)

No./acre (no./ha)

Mean
density

Lowest variance

Standard
deviation

No./plot

Mean
density

3.19

2.59

2.15

1.99

1.60

1.30

1.08

1.00

Relative cost

1.31

1.71

1.41

1

1.62

2.3

2.35

2.98

Relative
variance(RV)=

4.19

4.45

3.03

1.99

2.6

2.99

2.53

2.98

Product

116

116

76

68

144

156

126

202

No. of plots

Sample
Size

115 (46.5)

87 (34.9)

38 (15.1)

17 (6.8)

71 (28.8)

58 (23.4)

31 (12.6)

25 (10.1)

631

512

276

230

391

345

230

343

Dollars

Number
required

59.3 (24)

44.5 (18)

29.6 (12)

14.8 (6)

29.6 (12)

22.2 (9)

14.8 (6)

7.4 (3)

Acres (ha)

Sample
Size

Total cost

a Cost estimates taken from the General Cost per Sample Guidelines. A minimum of 60 samples is required.

5,412 (500)

(m2)

Subsegment33(10)

Feet2

Plot
size

10,824 (1000)

Subsegment66(20)

Plot
dimensions

5,412 (500)

Feet2 (m2)

Plot size

Subsegment33(10)

Plot
dimensions

Table 4—Optimal sheet: optimal plot size analysis for hard snags in single-stratum ponderosa pine landscapea

This is where consideration of a cost factor can aid the decisionmaking process.
On the Optimal sheet are six estimated costs for conducting surveys. These are
listed under the General Cost per Sample Guidelines lower on the Optimal sheet.
(See “Estimating Costs” in the “Computer Analysis” section for additional details).
We decided that the survey area could be easily walked, but visibility averaged 49 feet
(15 m). This puts us in a moderate situation because of the visibility restrictions.
Two density options are provided. Select the low density because our means appear
to be closer to two snags per acre (0.8 snags per ha) then to eight snags per acre (3.2
snags per ha). Now, copy the column values under Moderate; Low Density. Then paste
these values into the column titled Cost per Sample in the row above. Table 4 demonstrates the results when these values have been entered correctly. Refer to appendix 4
for Copy and Paste instructions.
The spreadsheet then calculates a relative cost for each of the eight plot sizes by
dividing the cost for each plot size by the lowest cost among them, which is 1.70.
Then, following Wiegert’s method (1962), we multiply the relative variance by the
relative cost. The plot size that minimizes the product of these two factors is considered
to be the optimal plot size. Once again, Segment33(10) plots appear to be Optimal
because they have the lowest relative variance and relative cost product (1.99). Now,
however, look at the column labeled Total Cost. This column calculates the cost based
on the minimum number of samples required; this is the lowest of either the recommended number of samples (Sample Size [plots]), or the cost to meet the minimum
sample size requirement of “60.” The spreadsheet bases the cost on the lowest of
these two values. For Segment33(10) plots, you could expect to spend about $230.
If Subsegment66(20) plots were used, however, the estimated total cost also is $230.
Subsequently, it is not clear which of these two plots would be optimal. We are also
interested in snags of all decay classes, however, and running the optimal plot analysis
on both hard and soft snags may aid in the decisionmaking process.
To run the analysis for snags in all decay classes, first return to Sheet 1. If necessary,
restore the data sheet to its original format by following the instructions given above in
the “Analyzing by Segment” section. Then you will need to rerun the Formmulti macro.
Refer to the “Formula” section above and enter everything exactly the same with the
exception of the decay class. When the input box asking for the maximum decay class
to consider appears, enter “5” instead of “3” this time. This will include both hard and
soft snags in the analysis. Then rerun the Segment and Subsegment macros exactly
as you did above. Make copies of both results’ tables and then transfer over to the
Optimal sheet. Then copy and paste the values under the Moderate; High Density
column in the General Cost per Sample Guidelines into the Cost per Sample column.
Use the High Density column this time. This high density choice will help to compensate for additional time spent sampling because of more snags encountered. Table 5
shows the results for both hard and soft snags.
In the analysis for both hard and soft snags, Segment33(10) plots again seem to be the
best choice in regards to the number of plots required for sampling. They require the
lowest sample size in plots (19) and in acres (5). (For the metric version, 1.9 ha are
required.) If this was one of multiple strata, this plot size would be the best. This is
best demonstrated by entering “20” in the box labeled Minimum Sample Size Required
to simulate this as one of three strata within a landscape, instead of a single stratum.
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1.2

10,824 (1000)
21,648 (2000)
32,472 (3000)
43,296 (4000)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(40)

3.66
2.82
1

16,236 (1500)

Subsegment132(40) 21,648 (2000)
10,824 (1000)
21,648 (2000)
32472 (3000)
43296 (4000)

Subsegment99(30)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(40)

2.11

2.11

2.11

2.11

1.91

Lowest total cost

6.7

4.8

3.8

4.3

3.4

2.4

1.9

8.5

4.60

2.72

1.70

3.19

2.30

1.36

0.85

1.68

2.16

1.5

1

2.82

3.66

3.53

5.68

4.45

3.51

2.53

1.99

2.23

1.76

1.27

1.00

Total cost
per plot
unit
Relative cost

6.38

1.06

1.06

1.06

1.06

Dollars

Cost per
sample

6.48 (40)

Lowest variance

14 (86.5)

9.7 (60)

6.5 (40)

18.3 (112.8)

23.7 (146.3)

22.8 (141.1)

36.8 (227.4)

10.9 (67)

4.96 (12.33)

5.63 (14)

4.83 (12)

4.53 (11.25)

4.96 (12.33)

5.63 (14)

4.83 (12)

4.53 (11.25)

Fixed
cost

3.274

2.791

1.549

.632

2.124

1.814

1.188

0.754

7.45

7.6

3.79

1.99

6.28

6.43

4.47

5.68

Product

37

40

21

19

62

67

50

110

Plots

Relative
Sample
Variance variance(RV)= size

No./acre (no./ha)

Mean
density

a Cost estimates taken from the General Cost per Sample Guidelines. A minimum of 60 samples are required.

1.68

2.16

1.5

3.53

10,824 (1000)

Subsegment66(20)

5.68

5,412 (500)

(m2)

Relative
variance

4.5

3.7

2.8

Subsegment33(10)

Feet2

Plot
size

2.25

Subsegment132(40) 21,648 (2000)

Plot
dimensions

1.85

16,236 (1500)

Subsegment99(30)

1.4

10,824 (1000)

Subsegment66(20)

0.6

No./plot

Feet2 (m2)
5,412 (500)

Mean Standard
density deviation

Plot size

Subsegment33(10)

Plot
dimensions

Number
required

509

403

290

229

264

225

145

210

Dollars

Total cost

37 (14.8)

30 (11.9)

11 (4.3)

5 (1.9)

31 (12.4)

25 (10.1)

12 (5)

14 (5.5)

59.3 (24)

44.5 (18)

29.6 (12)

14.8 (6)

29.6 (12)

22.2 (9)

14.8 (6)

7.4 (3)

Acres (ha)

Sample
size

Table 5—Optimal plot size analysis for both hard and soft snags in single stratum ponderosa pine landscapea

Nevertheless, a minimum of 60 samples is recommended to ensure that the assumptions of normality are met and the variability of the study area is adequately represented.
In situations like these, therefore, it is important to consider alternative plot sizes that
may require less sampling effort. Examine the Total Cost column to see that this time
Subsegment66(20) plots seem to be the optimal plot size because they are the least
expensive ($145). This result corroborates the results of the optimal plot analysis for
hard snags alone, which found that either Subsegment66(20) or Segment33(10) plots
would be optimal based on the estimated Total Cost. Consequently, Subsegment66(20)
plots seem to be the best plot size for sampling snags in this area; we will use this plot
size for the remainder of our analyses.
Density analysis—Now switch to the spreadsheet Densities by clicking on the tab with
this label in the Single.xls (Singlem.xls) file. Here a density estimate is calculated.
Begin with hard snags. Again, the shaded boxes are those that require input from you.
Leave the t-value at 1.67 even though this is the value that provides a 90 percent confidence level with 60 samples. Next enter 900 acres (364 ha) into the box labeled
Landscape Area. To obtain a density estimate and its bound, use the “Simple Random
Sampling Equation” section. Enter Subsegment66(20) in the gray box under the column
heading Plot Dimensions (name). The spreadsheet will then give you “10824” under
Plot Size (feet2). (For the metric version, under Plot Size (meters2) you will get “1000.”)
This will then convert the Plot Size into “Plot Area (acres [ha]).” Then input the estimated average density and standard deviation in snags per plot into the appropriate locations: “0.9 and 1.21” snags per plot, respectively. Finally, enter the number 20 into the
shaded box under the column heading “Sample Size.” The results are shown immediately below your entered values (fig. 5).

Figure 5—Density sheet. Estimated density results for single-stratum ponderosa pine landscape by
using optimal plot size: Subsegment66(20) plots. Results for qualifying hard snags in the Single.xls
(Singlem.xls) data set.
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The landscape supports 3.62 + 1.81 hard snags per acre (9.00 + 4.51 hard snags per ha).
To determine the precision of your estimate, the bound is divided by the mean. For this
example, the bound 1.81 is divided by the mean of 3.62 and the result is 50. This says
that you are 90 percent confident that your density estimate is within 50 percent of the
true mean. After obtaining the density results for hard snags, enter the average and
standard deviation of the Subsegment66(20) plots for both hard and soft snags.
These values are “1.4” and “1.188,” respectively. This results in a density estimate of
5.63 + 1.78 snags per acre (14 + 4.42 snags per ha).
Distribution analysis—The final objective for this snag survey is to determine whether
hard snags are adequately distributed to meet the needs of territorial cavity-nesters.
The Distribution spreadsheet bases its calculations on the percentage of the sampled
landscape with at least one qualifying snag present. The presence or absence of a
qualifying snag is evaluated on plots that are a subsample of an area about 10 acres
(4 ha) in size. Details about this index are given in the “Computer Analysis” section
under “Distribution Analysis.”
To begin (1) switch to Sheet 1; (2) make sure the data set is in its original state by deleting any results from the Segment or Subsegment macros and removing all Subtotals
following the instructions given above; (3) click on the width columns to ensure that the
formulas within these cells are for hard snags only (e.g., within the formula you should
find K<=3). If not, rerun the Formmulti so that only snags with the maximum decay
class III are counted following the instructions given above in the Formula section;
(4) then choose Macro from the Tools menu; (5) select Pres_Abs; and (6) click on Run.
Once the macro begins, (1) Enter: C1:E60 into the first input box labeled Copy Range.
(2) Press OK when the message box appears with this cell range. (3) For the next input
box, labeled Paste Range, enter the cell range C64. This will place the Subtotals below
the condensed rows. Then the macro will count how many segments were counted with
at least one qualifying hard snag present. (4) Another input box labeled Width33(10)
Range will come to the screen requesting the range of the newly pasted Width33(10)
column. Enter E65:E74. (5) Then you will notice that two additional column headings
are added to the right of the Width33(10) column. These are the Present and Count
fields. They should have the values “6” and “10,” respectively. Record these values to
enter onto the Distribution Index sheet.
Now bring up the Distribution Index sheet by clicking on the tab with this title. If this
sheet is not readily visible, use the right arrow keys at bottom left until it appears.
Enter the values for the Present and the Count shaded boxes (6 and 10, respectively).
Once adjusted, the Distribution Index for this example is 1.37 (table 6). Values of 1.00
or greater reflect a hard snag distribution similar to that found in old-growth forested
areas. This index value suggests, therefore, that the distribution of snags in this area
is adequate to meet the needs of territorial cavity-nesters.
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Table 6—Distribution spreadsheet: the distribution index for qualifying
snags for the single-stratum ponderosa pine landscapea

Present
6

Count(N)

Proportion of with
snag/tree

Proportion of plots
with snag/tree present
(adjusted)

10

0.6

1.37

Distribution Index

DI =

1.37

a Data from the Single.xls (Singlem.xls) file. Distribution Index values of 1.00 or greater
reflect a snag distribution similar to that found in old-growth forested areas.

Cavity analysis—To conduct cavity analyses, first return to Sheet 1 and restore the
data set to its original format by removing all results below the Grand Total row and the
Subtotals. Refer to directions given in the “Analyzing by Segment” section above for
complete details. The data in the Single.xls (Singlem.xls) file have been given codes for
cavity and forage use based on definitions described in appendix 2 (note: the cavity and
forage data have been created for demonstration purposes). To create the correct formula to determine the percentage of snags sampled that have been used for nesting
(either recently or in the past), (1) select Cavity from the Tools menu under Macro; (2)
then select Run; (3) enter 10 inches (25 cm) when an input box appears asking for the
minimum d.b.h. to consider for the analysis; (4) then enter 6 feet (1.8 m) when asked for
the minimum height; (5) for the maximum decay or structural class, enter “5”—this will
evaluate snags in all decay classes; (6) then when prompted for any species to exclude
enter “9999”—this will allow all species of snags to be included in the analysis; and (7)
finally, you will be asked for a cavity code: enter “1,” the code for any snag with a new
cavity (see appendix 2).
After building the correct formula, complete the following steps: (1) enter P2:P50 when
asked for the range of the Qualifying column; (2) when asked for the range of the
Cavity column, enter N2:N50; (3) then enter the range of the Qualifying column again.
Enter P2:P50 once more.
Now scroll to the top of the spreadsheet. There you will find three additional column
headings: (1) TOTAL, (2) UNKNOWNS, and (3) CAVSIGNS. You should find the values “45,” “8,” and “4,” in these columns, respectively. In addition, just below these field
names will be a row labeled Percent Use (Cavity) =. This will divide CAVSIGNS by the
(TOTALS-UNKNOWNS) to get the percent use. You should find the value “10.8.” This
means that 10.8 percent of the snags surveyed showed new signs of nesting.
Now to determine what percentage of the snags show both new and old cavity signs, (1)
first activate the cell P2 by clicking on it; (2) press the function key F2 at the top of your
keyboard. This allows you to edit the formula within this cell; (3) change the portion of
this formula that says N2=1 to N2<=3;
=IF(AND(K2<=16.5, L2>=10, M2>=6, J2<>9999, N2<=3),1,0) (English version)
=IF(AND(K2<=5, L2>=25, M2>=1.8, J2<>9999, N2<=3),1,0) (metric version)
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(4) then press Enter. This will cause the macro to include snags that have either new or
old cavities, or both (codes 1-3); and (5) copy and paste (see the Excel Commands
sheet [appendix 4] if necessary) this revised formula in cell P2 throughout the P column
under QUALIFYING (P3:P50). Notice that values in both the TOTAL column and in the
UNKNOWN column stay the same. The CAVSIGNS column, however, has changed to
“14.” Now your results should show that about 37.8 percent of the snags surveyed
showed some kind of nesting activity, at some point in time.
Conclusions for single stratum—Based on the 20 samples collected thus far, the
results are inconclusive as to whether the estimated density of hard snags (3.62 + 1.81
snags per acre [9.00 + 4.51 snags per ha]) on this landscape meets, or exceeds, the
targeted densities (2.2 snags per acre [5.4 snags per ha]) listed in the Forest plan.
More sampling is required, therefore, using the optimal plot size selected,
Subsegment66(20) plots, before any conclusions about density can be drawn. Results
from the distribution analysis suggest that hard snags are distributed evenly enough
across the landscape to meet the needs of cavity-nesters, but again are inconclusive
until 60 samples have been collected.
Example II: Density and
Distribution Analysis for
Subwatershed with
Multiple Strata

Background information—You are required to conduct a snag survey on one representative subwatershed to determine how effective management actions have been in
maintaining the desired snag densities. This is part of the compliance monitoring project
taking place forest-wide. The stands are dominated by Douglas-fir/western hemlock
forest communities. Because of limited resources, you are mainly interested in determining whether the subwatershed meets the guidelines for hard snags outlined in the
Forest plan. In addition, you would like to assess the distribution of the qualifying snags
encountered, and judge whether or not this distribution addresses the territorial needs
of cavity-nesters.
Subwatershed stratification—Aerial photographs show that the subwatershed is highly
fragmented. Information from the Forest’s GIS informs you that clearcutting has been
the primary method of timber harvesting. In addition, a snag-retention program was
initiated only 6 years ago. For a snag to meet the target criteria on this subwatershed,
it must have a d.b.h. ≥18 inches (46 cm), be ≥20 feet (6.1 m) tall, and be in the decay
classes I-III (Cline and others 1980). Because of the timber harvesting techniques used
within this area, and recent initiation of the snag retention program, you expect snag
densities to be low in second-growth and most clearcut stands. In the old-growth stands,
you expect to find high densities of target snags.
Based on snag densities alone, you think that two strata may be appropriate: (1) oldgrowth stands and (2) second-growth and clearcut stands combined. A thorough
ground check, however, reveals that although all old-growth stands may be combined
into one stratum, lumping the second-growth and clearcut stands would not be ideal.
It seems that once the clearcut stands reach a certain age, mobility and visibility away
from a center transect line are greatly decreased. You therefore decide to place all
clearcut stands that have been harvested in the past 10 years into their own stratum,
and to lump all older cut stands into another stratum labeled second growth.
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You now have three strata delineated: (1) clearcut, (2) second-growth, and (3) oldgrowth stands. You use the GIS to print out a map with all stands designated into one
of the three strata. These are color coded for quick, easy referencing. In addition, the
GIS output gives you the number of acres (ha) within each stand, and within the entire
subwatershed. Strata one, two, and three, have 1,759 acres (712 ha), 1,381 acres
(559 ha), and 1,243 acres (503 ha), respectively, for a total of 4,383 acres (1775 ha).
You then spend a day in the field, validating that each stand has been placed in the
proper stratum.
Pilot survey—The topography of the subwatershed differs from flat benches to steep
(>100 percent) slopes. Clearcutting has occurred predominantly on the flat areas.
Visibility within the clearcut stratum is unobstructed, travel is easy, and snag densities
seem low. You therefore preselect a plot size for sampling within this stratum to meet
your objectives. Subsegment132 (40) plots are the best choice to increase the probability of detecting a target snag, while minimizing the amount of sampling effort resulting
from the shorter plot size selected.
A preliminary review of the second-growth stands reveals difficult travel conditions and
low visibility. In addition, few, if any, target snags are expected because of a zero snag
retention policy when these stands were harvested. You therefore also preselect a plot
size for use within this stratum. Subsegment66 (20) plots are narrow enough to ensure
that any target snags out to 33 feet (10 m) from the center line are detected. Again, the
shorter plots will meet the requirement of a minimum sample size more quickly.
By contrast, it is not clear what plot size would be the best choice within the old-growth
stratum where snag densities appear highly variable. Visibility averages about 49.5
feet (15 m), and mobility varies from moderate to difficult, because of large volumes of
downed woody debris and dense tree and shrub regeneration in places. Consequently,
you will conduct a formal Optimal Plot Size analysis within this stratum.
Five stands within each stratum were randomly selected for the establishment of transects across the subwatershed. Random starting points for each transect were selected
by placing a grid over each stand and then randomly selecting a grid intersection for the
starting point. The compass direction was also randomly determined. Each transect
was then delineated into four subsegment plots for a total of 20 samples within each
stratum. As described above in “Example I,” two consecutive subsegments make up
one segment. A hip-chain was used to measure the 164-foot (50-m) plot lengths and to
function as the center line of the plots.
All qualifying snags within each subsegment were counted out to 66 feet (20 m) from
the center line in strata 1 and 3, following the methods described in “Example I” of
the “Tutorial.” By contrast, target snags were only counted out to 33 feet (10 m)
within stratum 2.
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Data entry—Data for all strata within this subwatershed were entered onto Sheet 1 of
the file named Strate.xls (Stratm.xls). It may be accessed in the spreadsheet program
Excel for Windows, Version 5.0. Open this file and you will find that 20 subsegments,
nested within 10 segments, of data have been entered for each stratum. There are a
total of 60 subsegment samples. (If these were your own data, you would run the macro
Consecutive before beginning any computer analyses. Please refer to the “Computer
Analysis” section for information on this macro.) You now want to run the analyses necessary to determine which of the eight available plot sizes minimizes your sampling
effort for snags within each stratum.
Formula entry—As in the single stratum example, the first step in the computer analysis is to fill in the appropriate formulas for each of the Width columns. This is done by
the macro Formmulti. To activate the macro, (1) find Macro under the Tools menu, (2)
highlight Formmulti, and (3) press Run.
To create the correct formula for a target snag analysis, (1) enter 18 inches (45 cm) into
the DBH input box; (2) press OK to continue; (3) next, enter 20 feet (6.1 m) into the
height input box; (4) the next input box will ask for the maximum decay class to consider
in the analysis. Enter the number “3.” This is based on the decay class descriptions
of Cline and others (1980), where hard snags were those in Decay Classes I-III; and
(5) enter “9999” into the species input box to specify that you want all snag species
considered in the analysis.
Now to paste the correct formula for target snags into the Width columns, enter E2:E116
when asked for range of the Width33(10) column. Use the scroll bar on the right side of
the screen to determine the last row in the Width33(10) column. You will be prompted to
enter the individual ranges of the Width66(20), Width99(30), and Width132(40) columns.
Your entries should be F2:F116, G2:G116, and H2:H116, respectively. The spreadsheet
will then enter “1s” and “0s” into each cell within these columns. A “0” is given if the
snag within that row fails to meet all of the target qualifications. A “1” is given if the snag
meets all the specifications you entered into the Formmulti macro above.
Sorting strata—The next step is to sort, and then to separate, the main data set on
Sheet 1 into the three individual strata. This is necessary to obtain estimates of the
averages and standard deviations for each stratum. To begin, (1) select Macro from the
Tools menu; (2) click on Sort; and (3) click on Run. This macro will first sort the data, in
ascending order, by stratum number.
The macro will then copy each stratum’s data rows onto a separate sheet. Follow these
steps to complete this process. First, enter A2:O21 into the input box requesting the
“range of Stratum 1.” Use the scroll bar to determine the range. As stated above, using
the mouse will cause the macro to abort. Then another input box will come up asking
for the “range of Stratum 2 (A?:O?).” Enter A22:O41. The next input box will ask Do
you need to move another stratum? Click on Yes. Enter A42:O116 into the input box
requesting the “range of Stratum 3.” Finally, when the message box asking Do you
need to move another stratum? appears, press No. Now the data rows for each stratum
have been copied and pasted onto three individual sheets within this same file: (1)
Stratum1, (2) Stratum2, and (3) Stratum3.
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Analyzing by segment and subsegment with multiple strata—When working with
multiple strata, it is important to run both the Segment and Subsegment macros on
each stratum to obtain averages and standard deviations before proceeding to the next
stratum, unless a plot size was chosen before sampling began. This is necessary
because both macros transfer results directly to the “Optimal” sheet on completion.
If you switch to a different stratum before running both the Segment and Subsegment
macros on one stratum, you will get mixed results from two different strata. To ensure
that the correct values are transferred to the “Optimal,” always print out the Segment
and Subsegment plot statistics on completion. See tables 7 and 8 for examples of
these results.
Table 7—Segment plot statisticsa
Plot dimensions

Average

Standard deviation

Segment33(10)

0.7

0.675

Segment66(20)

1.6

1.174

Segment99(30)

2.2

1.476

Segment132(40)

2.7

1.889

N

10

a Averages and standard deviations for each plot size in stratum
three, along with total sample size, using the Strate.xls (Stratm.xls)
data set. Analysis for hard snags from old-growth Douglas-fir/
western hemlock forest subwatershed.

Table 8—Subsegment plot statisticsa
Plot Dimensions

Average

Standard deviation

Subsegment33(10)

0.35

0.489

Subsegment66(20)

.8

.894

Subsegment99(30)

1.1

1.021

Subsegment132(40)

1.35

1.387

N

20

a Averages and standard deviations for each plot size in stratum
three, along with total sample size, using the Strate.xls (Stratm.xls)
data set. Analysis for hard snags from old-growth Douglas-fir/
western hemlock forest subwatershed.
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Stratum 1 analysis—Using the arrow keys in the bottom left corner of the screen, click
several times in the right direction until you see a sheet labeled Stratum1. Click on this
tab. Here are the 20 subsegment samples taken during the pilot survey from Stratum 1,
composed of the clearcut stands. Scrolling down through the data you will quickly notice
that only one qualifying snag was encountered during the pilot survey. You still need to
run, however, the Subsegment macro to get a snag average and
standard deviation for the Subsegment132(40) plot size.
To begin, (1) click on Macro from the Tools menu, (2) select Subsegment, and (3) Click
on Run. Next, follow these steps for the correct entries into each of the input boxes:
(1) For the first input box, Copy Range, enter D1:H41. Press OK when each of the message boxes throughout this section appear with the correct cell addresses for confirmation. (2) Enter D45 into the second input box titled Paste Range. The summed rows will
be pasted here. (3) The next input box, Width33(10) Statistics asks for the “range of the
newly pasted Width33(10) column.” Enter E46:E65. (4) Then, enter E68 into the input
box labeled SUBSEGMENT Results. The table of results will be placed here.
(5) Three additional input boxes will appear asking for the ranges of the newly pasted
Width66(20), Width99(30), and Width132(40) column ranges. Enter F46:F65, G46:G65,
and H46:H65, respectively. And (6) finally, a message box labeled “More Analysis” will
appear. Click on No. Clicking Yes will transfer you to the Optimal sheet. The Optimal
Plot Size analysis, however, is not necessary because we preselected the plot size to
use within this stratum.
Now scroll down to find a table with the Subsegment results. Only the Subsegment99(30)
and Subsegment132(40) plot sizes have values other than “0.” Both of these plot sizes
will have 0.05 (snags per plot) for their averages and 0.224 (snags per plot) for their
standard deviations. Because the center of the single snag encountered had a distance
greater than 33 feet (10 m) from the center line, it did not qualify for the Width33(10)
or Width66(20) plot sizes. Therefore, each of these plot sizes have the value 0.0 for
both their averages and standard deviations. Print, or record these values for further
analysis. To print the results, (1) highlight the range with the mouse, (2) select Print
from the File menu, and (3) choose Selection.
If the macro ever stops because a cell range was entered incorrectly, you will see an
error message box. Click End within the message box and then proceed with the
following steps to restore the sheet to its original format: (1) select all rows containing
data beneath the Grand Total row (2) select Delete from the Edit menu (3) click on
Entire Row (4) then activate the cell with the field name SUBSEGMENT (5) from the
Data menu choose Subtotals; and (6) select Remove all. This will return the data set
to its original format.

Stratum 2 analysis—Click on the tab labeled Stratum2; this contains data from the
second-growth stratum. Scroll down through the data set. Note that no target snags
were encountered during the pilot survey within this stratum. Subsequently, it is not
necessary to run either the Segment or Subsegment macros for this stratum.
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Stratum 3 analysis—Now click on the tab labeled Stratum3 in the lower left corner of
the screen. These are the data from the old-growth stratum. Begin your analysis by
obtaining averages and standard deviations for each 328-foot (100-m) long Segment
plot within this stratum. To begin this process, (1) choose Macro from the Tools menu,
(2) click on Segment, and (3) highlight Run. After the macro sums and condenses the
rows, a series of input boxes will appear. Follow these steps for the correct entries:
(1) For the Copy Range input box enter C1:H86. Then the macro double checks to see
that you entered the correct range. Click on Yes if correct, otherwise click No and reenter the range. (2) Then the Paste Range will come up. Enter C90 as the location to
paste the data rows. (3) For the Width33(10) Statistics input box, enter E91:E100.
(4) For the SEGMENT Results input box, enter the cell range E103. Your table of results
will be placed here. (5) Then for the ranges of the Width66(20), Width99(30),
and Width132(40) newly pasted columns, enter F91:F100, G91:G100, and H91:H100,
respectively. (6) When asked whether you want to switch to the Optimal sheet,
click on No. Now scroll down to examine, and record the results (table 7). Follow the
directions given above to print your results. You will find that an average of 0.7 snags
per plot were found in the Segment33(10) plot size. This is for a plot size 328 by 33 feet
(100 by 10 m). The standard deviation was 0.675 snags per plot. Segment66(20),
Segment99(30), and Segment132(40) plots each had an average of 1.6, 2.2, and 2.7
snags per plot, respectively. The column to the right of the averages lists the corresponding standard deviation for each plot size (table 7).
The next step in the Stratum 3 analysis is to obtain the averages and standard deviations for each Subsegment plot 164 feet (50 m) in length. To begin this process: (1)
Remove any results from the Segment macro analysis following the directions given
above with the exception of “Step 4.” Here you should highlight the field name SEGMENT, rather than SUBSEGMENT. (2) Then select Macro from the Tools menu. (3)
Highlight Subsegment. And (4) Click on Run.
Follow these steps so that correct cell ranges are entered within each of the input
boxes. Enter D1:H96 into the input box labeled Copy Range. When asked by the next
input box whether the range you entered was correct, press Yes if it was, No if not.
Reenter the correct range if necessary. The Paste Range input box should appear.
Enter D100 to have the newly pasted data rows copied here. For the Width33(10)
Statistics input box type in E101:E120. Then direct the macro to place the SUBSEGMENT Results table in the cell E123. Next, for the ranges of the newly pasted
Width66(20), Width99(30), and Width132(40) columns, enter F101:F120, G101:G120,
and H101:H120, respectively. Finally, a More Analysis? input box will appear. Choose
No to first print the results from your Subsegment analysis before transferring to the
Optimal sheet. Table 8 shows the correct averages and standard deviations for each
of the Subsegment plot sizes.
Optimal plot size—For this example, only the old-growth stratum is available for the
Optimal plot size analysis because plot sizes were preselected for the clearcut and
second-growth strata. To begin the Optimal Plot Size, first transfer to the Optimal sheet
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if you have not already. Use the tabs in the lower left corner of the screen to activate
the Optimal sheet. The averages and standard deviations for the old-growth stratum
for each of the eight plot sizes available should have already been transferred by the
Segment and Subsegment macros (table 9).
Now follow these steps to furnish the necessary information to aid in the decisionmaking
process: (1) Enter the number “20” into the box labeled Minimum Sample Size
Required. You enter “20” because you have three strata and need a minimum of 20
samples within each stratum for stratified landscapes. (2) Next, examine the values in
the Mean Density (no. per acre) column. Are they closer to two snags per acre (0.8
snags per ha) or eight snags per acre (3.2 snags per ha)? They are closer to two snags
per acre (0.8 snags per ha). Therefore, copy the estimated prices for a difficult, low
snag density situation and then paste these into the Cost per Sample column above
(table 9). (Note: If both hard and soft snags were included, the density would be high).
Select the difficult category because of large amounts of downed woody debris and
dense shrub cover in mainly steep areas.
To choose the Optimal plot size, consider these factors: (1) Segment99(30) plots require
the lowest number of plots (31) to be sampled, whereas Segment33(10) plots require
the smallest amount of acreage (16 acres [6.5 ha]) to be sampled. (2) Now look at the
values listed in the Product column. When the relative costs have been multiplied by
the relative variances, we find the Segment66(20) plots have the lowest product (3.32)
of the eight plot sizes. Therefore, based on Wiegert’s (1962) method, this is the optimal
plot size to use to sample for snags in this forest stratum. (3) Now look at the column
Total Cost. Do the results within this column support what we found in the Product
column? Yes, they do. If we use this plot size, we would minimize our costs ($181)
to obtain the desired level of precision. In addition, we would not be jeopardizing our
accuracy by trying to sample beyond the point of clear visibility from the center line.
Segment66(20) plots therefore seem to be the optimal plot size to use within stratum
three, and we will use this plot size for the remainder of the analyses.
Stratified density analysis—Your next objective in this process is to obtain an estimate
of the required sample size for this subwatershed. To accomplish this, however, we
must first have an estimate of the stratified mean density to enter into the Sample Size
equation. To obtain the stratified density estimate follow these steps: (1) Click on the
tab labeled Densities. (2) Go to the section titled Stratified Random Sampling Equation.
(3) Enter the number of strata within the subwatershed in the shaded box labeled
Stratum. For this example, there are three strata so enter the numbers 1, 2, and 3. (4)
Enter the name of each plot size selected for sampling within each stratum under Plot
Dimensions (name). Stratum one used Subsegment132(40) plots, stratum two used
Subsegment66(20) plots, and three used Segment66(20) plots. The spreadsheet will
then provide the area in square feet (m) under the Plot Size column. This translates
into 21,648 feet2 (2000 m2) for the Subsegment132(40) and Segment66(20) plots and
10,824 feet2 (1000 m2) for the Subsegment66(20) plots, respectively. Notice that the
default area here is 5,412 feet2 (500 m2). Double-check to ensure that the correct area

52

53

16,236 (1500)
21,648 (2000)
10,824 (1000)
21,648 (2000)
32,472 (3000)
43,296 (4000)

Subsegment99(30)

Subsegment132(40)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(40)

10,824 (1000)
16,236 (1500)
21,648 (2000)
10,824 (1000)
21,648 (2000)
32,472 (3000)
43,296(4000)

Subsegment66(20)

Subsegment99(30)

Subsegment132(40)

Segment33(10)

Segment66(20)

Segment99(30)

Segment132(40)

0.35

1.00

1.09

1.55

2.04

2.16

2.08

3.59

4.3

Relative
variance

2.7

2.2

1.6

0.7

1.35

1.1

.8

Standard
deviation

2.72 (6.75)

2.95 (7.33)

3.22 (8)

2.82 (7)

2.72 (6.75)

2.95 (7.33)

3.22 (8)

2.82 (7)

11.56

9.18

2.72

2.38

5.78

4.59

1.36

1.19

Dollars

Cost per
sample

Lowest total cost =

2.11

2.11

2.11

2.11

1.06

1.06

1.06

1.06

Fixed
cost

Variance

(80)

2.25

13.7

11.3

4.8

4.5

6.8

5.7

2.4

2.3

Total cost
per plot
unit

6.08

5.02

2.15

2.00

3.04

2.51

1.08

1.00

Relative cost

1.00

1.09

1.55

2.04

2.16

2.08

3.59

4.3

6.08

5.45

3.32

4.08

6.56

5.22

3.86

4.3

Product

34

31

38

65

74

60

87

136

Plots

Relative
Sample
variance(RV)=
size

3.61 (22.29)

3.6 (22.3)

3.9 (24.2)

5.6 (34.4)

7.4 (45.6)

7.8 (48.1)

7.5 (46.3)

13

15.5 (95.8)

No./acre (no./ha)

Mean
density

Lowest variance

1.889

1.476

1.174

0.675

1.387

1.021

.894

0.489

No./plot

Mean
density

Number
required

466

354

181

291

503

339

211

307

Dollars

Total cost

34 (13.6)

23 (9.4)

19 (7.5)

16 (6.5)

37 (14.7)

22 (9)

22 (8.7)

17 (6.8)

17.8 (7.2)

13.3 (5.4)

8.9 (3.6)

4.4 (1.8)

8.9 (3.6)

6.7 (2.7)

4.4 (1.8)

2.2 (0.9)

Acres (ha)

Sample
size

Strate.xls (Stratm.xls) file. Cost estimates taken from the Optimal spreadsheet in the General Cost per Sample Guidelines section.

a Optimal plot size analysis for hard snags in stratum three of the Douglas-fir/western hemlock forest subwatershed. Data from the

5,412 (500)

Subsegment33(10)

Feet2 (m2)

Plot
size

10,824 (1000)

Subsegment66(20)

Plot
dimensions

5,412 (500)

Feet2 (m2)

Plot size

Subsegment33(10)

Plot
Dimensions

Table 9—Optimal spreadsheeta

size is being used. Also make sure you use the appropriate Plot Size name depending
on if you are using the metric or English spreadsheet. (5) Enter the number of acres
(ha) found within each stratum under Stratum Size (acres [ha]). There were 1,759,
1,381, and 1,243 acres (712.1, 559.1, and 503.2 ha, respectively), for strata one, two,
and three, respectively. (6) Enter the estimated densities and standard deviations for
each plot size within each stratum under Average Density (no. per plot) and Standard
Deviation (no. per plot), respectively. For stratum one, enter 0.05 for the average density
and 0.224 for the standard deviation. For stratum two, enter 0.00 for both of these values. For stratum three, enter 1.6 and 1.174 for the average and standard deviation,
respectively. (7) Finally, enter the number of samples you have for each stratum in the
column Sample Size. This should be “20” for strata one and two. You should enter “10”
for stratum three. The results from the Densities spreadsheet, shown in figure 6,
estimate the average density on this subwatershed to be 0.953 + 0.359 target snags
per acres (2.37 + 0.89 snags/ha).
Sample size determination—The next step in the analysis for multiple strata is to
obtain an estimate of the required sample size to obtain your desired level of precision.
The sample sizes required for stratified subwatersheds are calculated on the sheet
labeled “Sample Size.” Click on the tab in the lower left of the screen to bring up this
spreadsheet. Again, all shaded boxes require values to be entered. Notice that one of
the first pieces of information required is an estimate of the stratified mean. This was
estimated for you on the spreadsheet labeled Densities (fig. 6). Enter this value (0.953
snags per acre [2.37 snags per ha]) into the Pilot Sample Mean box.
Next, follow these steps to supply the correct information to the sample size spreadsheet: (1) Enter the number of strata you have under Stratum Number. For this example, there are three strata, so enter the numbers 1, 2, and 3. (2) Highlight the box where
the number “4” would go if there were four strata and press Delete. This is to ensure
that the spreadsheet uses the appropriate sample size equation. (3) Enter the number
of acres found within each stratum under Stratum Size (acres [ha]). There were 1,759,
1,381, and 1,243 acres (712.1, 559.1, and 503.2 ha), for strata one, two, and three,
respectively. (4) Enter the name of each of the plot sizes selected for sampling within
each stratum under Plot Dimensions (name). Stratum one used Subsegment132(40) plots,
stratum two used Subsegment66(20) plots, and stratum three used Segment66(20) plots.
(5) Finally, enter the estimated average densities and standard deviations
for each plot size within each stratum under Average Density (no. per unit) and Standard Deviation (no. per unit). These should be 0.05 and 0.224, 0.00 and 0.00, and 1.6
and 1.174 for strata one, two, and three, respectively.
For the results, scroll to the bottom of the Sample Size page (fig. 7). First, look in the
section under the heading Optimal Allocation. This method, which incorporates the stratum variances into its calculations, estimates that only 54 (52) samples will be required
to obtain a stratified mean that is within 20 percent of the true mean, 90 percent of the
time. These 54 (52) samples are then divided among the three strata. It estimates that
only 11 plots are needed in stratum one (clearcuts), none in stratum two (second
growth), and 43 (41) are required in stratum three (old growth).
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Now look in the section under the heading Proportional Allocation. This method uses
the overall variance of the subwatershed and then allocates the samples based on the
size of each stratum. Here it is estimated that 128 samples must be taken to obtain the
same level of precision. This translates into 51, 40, and 36 plots, of the appropriate
size, to be sampled within each stratum.

Figure 6—Densities spreadsheet. Stratified mean density estimate with a 90 percent confidence interval for qualifying hard snags for the Douglas-fir/western hemlock forest watershed. Data from Strate.xls (Stratm.xls) file.
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Figure 7—Sample Size spreadsheet. Optimal and proportional sample size calculations for
sampling hard snags in each of the three strata on the Douglas-fir/western hemlock
subwatershed. Data from the Strate.xls (Stratm.xls) file.
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You will notice that the two sample size equations are close in agreement about the
number of samples to take in stratum three. Within strata one and two, however, there
are large discrepancies. The optimal method suggests focusing most of the sampling
effort in stratum three (n = 43), which has the largest variance relative to the other strata. The optimal method recommends no samples should be taken in stratum two,
whereas the proportional method suggests 40 sample plots.
The results of the optimal allocation method recommending zero samples in stratum two
is a problem. Although on subwatersheds where clearcutting has been the primary
method of timber harvesting, and target snags within cut stands may be rare or nonexistent, it is still necessary to sample stands within these strata. Small values for both
the average and standard deviation within this stratum therefore should be entered. For
example, enter 0.01 for the average and 0.05 for the standard deviation. Examine figure 8 for the results. Now the optimal method requires four samples within stratum two.
We still recommend, however, that a minimum of 20 samples (from a minimum of five
stands) be taken within every stratum regardless of the estimated sample size required.
In this example, we would recommend not sampling within strata one and two anymore,
unless you think that encountering zero snags within these stands for the pilot sample
was an inaccurate representation of the conditions within these strata. Rather, focus
your sampling effort in stratum three by surveying 10 additional Segment66(20) plots.
These would best be distributed among three different stands. After these 10 plots have
been sampled, you will have met your minimum sample size requirement of 60. You
can then reanalyze the data to determine whether you want to continue sampling to
increase the precision of your estimate, or stop sampling because the estimate is precise enough to meet your objectives. It is important to remember that the most any
sample size equation can give you is an estimate of the number of samples required.
As additional data are collected, entered, and analyzed, therefore, you may find the variances, and consequently the required sample size, changing within a stratum. This
possibility increases if the pilot sample data turn out to be a poor representation of the
variation within a stratum. Consequently, the best way to avoid oversampling (where
large sample sizes are required) is to continually enter your data and periodically calculate a mean density and its bound to determine the current level of precision.
Also, please refer to the discussion of Sample Size Determination in the “Computer
Analysis” section for a discussion of the advantages and disadvantages of optimal
and proportional allocation methods for determining your sample size.
Compare to target density—Let us now assume that 60 samples have been taken
and, therefore, it is possible to test whether the estimated density of qualifying snags
meets the targeted density listed in the Forest plan. You already have the bound on the
density estimate for the 90 percent confidence interval. See the Densities sheet. This
is 0.953 + 0.36 target snags per acre (2.47 + 0.90 snags per ha). Now bring up the sheet
labeled Statistical Test by clicking on this tab. To conduct the test, follow these steps:
(1) Create your null hypothesis: Ho: There is no difference between the estimated and
the targeted hard snag densities. (2) Let us assume that the target density for hard
snags on this subwatershed is 1.51 snags per acre (3.73 snags per ha). Enter this
value into the shaded box labeled Target Density. (3) Enter the estimated snag density
of 0.953 snags per acre (2.37 snags per ha) into the shaded box labeled Estimated
Density. (4) Enter the estimated bound for a 90 percent confidence interval: 0.36 (0.89).
See table 10 for the correct entries.
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Figure 8—Sample Size spreadsheet. Optimal and proportional sample size calculations for
sampling hard snags in each of the three strata on the Douglas-fir/western hemlock forest
subwatershed. Stratum two average density and standard deviation have been adjusted to
compensate for zero snags encountered. Data from the Strate.xls (Stratm.xls) file.
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1.60
1.40

Numbers
Numbersper
peracre
acre

1.20
1.00
0.80
0.60
Target density
0.40

Estimated density

0.20

Upper limit
Lower limit

0.00
90
Confidence interval
Figure 9—Statistical Test spreadsheet. Graph depicting test for significant difference between estimated and
targeted densities of qualifying snags on Douglas-fir/western hemlock subwatershed. Input data from table 10.

Table 10—Statistical Test spreadsheet. The target density and the estimated snag
density and its bounds for qualifying hard snags for the Douglas-fir/western hemlock forest subwatershed. Data from the Stratify.xls file used to create figure 5.
Percent
confidence
interval
90

Target
density
acre (no./ha)

Estimated
density
acre (no./ha)

Upper limit

Lower limit

Bound

1.51 (3.73)
1.51 (3.73)
1.51 (3.73)

.996 (2.47)
.996 (2.47)
.996 (2.47)

1.356 (3.37)
1.356 (3.37)
1.356 (3.37)

.636 (1.57)
.636 (1.57)
.636 (1.57)

.36 (.90)
.36 (.90)
.36 (.90)

Once the necessary information has been entered into the spreadsheet portion of the
Statistical Test sheet, a graph depicting the results is automatically created (fig. 9).
Looking at the graph, you can see that the line representing the target density for snags
does not enter within the upper and lower limits of the estimated density. You can therefore reject the null hypothesis, which states that “there is no difference between the
estimated and targeted snag densities.” This test suggests that you can be 90-percent
confident that the snag density on this subwatershed fails to reach the targeted density.
Now you have satisfied the requirements of your first objective: to determine whether
or not the subwatershed met the targeted hard snag density. Subsequently, you can
decide whether or not to continue sampling to obtain a more precise density estimate.
Stratified distribution analysis—To obtain the necessary information to conduct a distribution assessment for this subwatershed, you will need to run the macro Pres_Abs
for each stratum with snags present. Details for this index are given in the “Computer
Analysis” section under “Distribution Analysis.”
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Start with stratum one and complete these steps: (1) click on the Stratum1 tab to activate the sheet; (2) remove any subtotals that may be present (for detailed instructions
see “Restoring Sheet to Original Format” in appendix 4); (3) once the sheet is returned
to its original format, select Macro from the Tools menu; (4) click on Pres_Abs; (5) then
highlight Run. The macro will sum and condense the data rows for each Segment33(10)
plot; (6) then enter C1:E31 into the input box labeled Copy Range; (7) for the Paste
Range input box enter C34; (8) enter E35:E44 into the input box labeled Width33(10)
Range for the range of the newly pasted Width33(10) column; and (9) record the
Present and Count field values to enter onto the Distribution Index sheet. They should
have the values “0” and “10,” respectively. These fields are added to the right of the
Width33(10) column.
Skip the process for stratum two, because no target snags were encountered there.
Then repeat the above procedure for stratum three. For example: (1) click on the
Stratum3 tab to activate the sheet; (2) remove any subtotals that may be present (for
detailed instructions see “Restoring Sheet to Original Format” in appendix 4); (3) once
the sheet is returned to its original format, select Macro from the Tools menu; (4) click
on Pres_Abs; and (5) then highlight Run. The macro will sum and condense the data
rows for each Segment33 (10) plot. (6) When asked to enter the Copy Range, enter
C1:E86; (7) for the Paste Range enter C89; (8) enter E90:E99 for the newly pasted
Width33(10) Range; and (9) record Present and Count field values. They should be “6”
and “10,” respectively.
Now, to correctly enter the correct values onto the Distribution Index sheet follow these
steps: (1) activate the Distribution Index sheet by clicking on the tab with this title; (2) go
to Multiple-Strata Distribution Index section; (3) under Stratum enter the numbers 1, 2,
and 3 to indicate that there were three strata on this subwatershed; (4) in the cell where
the number 4 would go if there were four strata, press Delete; and (5) then enter the
number of acres of each stratum under Stratum Size (ac). These were 1,759, 1,381,
and 1,243 acres (712.1, 559.1, and 503.2 ha), for strata one, two, and three, respectively. (6) Next, enter the values “0” and “10” for the Present and the Count fields, respectively, for both strata one and two. (7) For stratum three enter “6” and “10” for the
Present and Count fields, respectively. Results show the distribution index for this subwatershed to be 0.39 (fig. 10). This means that it is questionable whether the habitat
needs of territorial cavity-nesters are being met on this subwatershed (see details in the
“Computer Analysis” section under “Distribution Analysis”).
Conclusions for multiple strata—The density and distribution results of this analysis
suggest that the necessary snag resources to sustain woodpecker populations may
be inadequate on this subwatershed. Based on the results of the Compare to Target
analysis, estimated snag densities were less than the targeted snag densities listed in
the Forest plan. In addition, results from the distribution analysis indicate that large portions of the landscape do not support any snags at all. This can be a problem because
woodpeckers are territorial. These tests are not conclusive, however, unless a minimum
of 60 samples has been taken on a subwatershed of this size.
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Proportion of
Proportion of plots
Distribution
plots with
with snag/tree present
Index
snag/tree present
(adjusted)
equations

Stratum

Stratum size in
acres (h/a)

Present

Count (N)

1

1,759 (712.1)

0

10

0

0

2

1,381 (559.1)

0

10

0

0

0.00

3

1,243 (503.2)

6

10

0.6

1.37

0.36

0

0

0.36

Total acres

4,383 (1,774.4)
Distribution Index:

DIst =

0.39

Figure 10—Distribution Index spreadsheet. The distribution index for qualifying snags for the Douglas-fir/
western hemlock subwatershed. Data from the Strate.xls (Stratm.xls) file. Distribution Index values of 0.40
or less indicate a poor snag distribution.

At this point, you have several management options. First, you may want to continue
sampling to increase the precision of your estimates and to determine whether this
changes the results of your analyses. Second, you may want to examine recent
clearcut areas for the number, and quality, of the retention snags. Third, you may want
to work with foresters to increase snag retention efforts. Finally, you may want to initiate
snag creation programs to increase the density and improve the distribution of snags on
this subwatershed.
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Appendix 1:
General Snag
and Large Tree
Sampling
Guidelines

I. Landscape definition and selection (these snag and large tree sampling methods are
intended for use on a landscape, or subwatershed, scale; they are not intended for
sampling on the individual stand (<100 acres [40 ha]) where complete counts are
more appropriate).
A. Select landscape.
B. Delineate boundaries if necessary.
II. Sampling objectives
A. Size and condition of snags and large trees to be surveyed
1. Decide what diameter of snags or large trees will be surveyed.
2. Decide what height of snags will be surveyed.
3. What condition of snags and large trees will be surveyed?
a. Both hard and soft snags?
b. All trees? Just hollow trees?
4. Should any species be excluded? For example, if a particular tree species is
known to provide little, if any, wildlife value, should it be excluded from your
sampling program?
5. Should wildlife use signs be recorded (e.g., woodpecker foraging and nesting
signs)?
B. Density estimate objectives
1. Estimate average density.
2. Compare to target density.
C. Obtain a distribution index.
III. Landscape stratification
A. Visit the area if you are unfamiliar with it. Landscape patterns unclear on maps
may become apparent from an initial ground survey. What are the obvious differences visible across the landscape? What are the similarities? Would combining
stands into strata that are homogenous in regards to snag or large tree densities,
or forest structure, increase your precision? Decrease your sampling effort? If so,
begin the stratification process.
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B. Obtain several reference maps of landscape for use in the field: geographical information system (GIS) or Orthoquad maps, or both, containing the
following information:
1. Current road system (use maps scaled to 1:31,680 or less)
2. Stand units and their unique numeric identifier
3. Current seral stage of vegetation
4. Aerial photographs of the survey area.
C. Run a query by using either the GIS or any stand exam database available.
Obtain any, or all, of the following information for each stand if it will aid in the
stratification process:
1. Forest community type
2. Management history (i.e., harvest information, prescribed burns)
3. Seral stage
4. Predicted snag and large tree densities.
D. Visit area with above information.
E. Assign each stand to a stratum.
F. Obtain number of acres (ha) within each stand or stratum.
IV. Surveying procedures
A. Establishing transects
1. Option 1: randomly place transects across landscape.
a. Randomly place a grid over the subwatershed map.
b. Select five grid points within each stratum that will be used to establish
starting points for each transect.
c. Randomly select five compass bearings for each of the transect
starting points.
d. Determine if each of the five transects within each stratum fall within sufficient area of the stratum to allow four sample subsegments (164 feet [50
m]) to be placed; if not, select additional transects and starting points until a
total of 20 samples (subsegment lengths), from a minimum of five stands,
have been located within each stratum.
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2. Option 2: Randomly select stands. For use in highly fragmented landscapes with
many small stands.
a. Randomly pick stand unit numbers from the complete list of stands within that
stratum for sampling.
b. Select a random point along the road bordering the stand to use for entry into
the stand.
c. Then from the point along the road selected above, randomly select a starting
point from which to establish a transect perpendicular to the road within 164
feet (50 m) of the edge of the stand.
d. Continue stand selection until a total of 20 samples (subsegment lengths), from
a minimum of five stands, have been located within each stratum.
B. Plot size selection
1. Prepilot sampling plot size selection, for example:
Based on information gathered during the stratification process, it may be
beneficial to preselect a plot size for sampling. For example:
a. In open, clearcut strata supporting low densities (<1per acre [0.4 per ha])
of snags or trees, use Subsegment132(40) plots.
b. In dense (visibility <33 feet [10 m]) strata supporting low densities (<1 per acre
[0.4 per ha]) of snags or trees, use Subsegment66(20) plots.
c. See appendix 3 for other situations where plot sizes may be preselected.
2. Postpilot sampling plot size selection
In most forested conditions, the optimal plot size to use for sampling is unknown
until the density and distribution of the snags or trees can be evaluated.
In these situations therefore:
a. Use pilot sample data to determine which plot sizes minimize
sampling effort to obtain your desired objectives. See “Optimal Plot
Size Analysis” section for details.
b. Use Optimal plot size for remainder of survey.
C.

Field surveying techniques
1. Establish transects by using a hip-chain starting from the points selected above.
The hip-chain line also marks the center of the strip transect.
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2. Delineate subsegment lengths (164 feet [50 m]) along the transect. Assign
a unique numeric identifier to each subsegment as you sample (see appendix 2
for details).
3. Always sample subsegment lengths in sets of two. Two subsegments equal one
segment. This will allow macros to help you determine whether shorter or longer
plots are more efficient for your specific forest conditions. This is a function of the
density and distribution of snags or trees in the area. This also allows you to
obtain a Distribution Index.
4. For each subsegment length during the pilot survey, conduct a complete count of
all qualifying snags or trees out to 66 feet (20 m) from the center line.
5. Record the perpendicular distance from the center line to the midpoint of each
snag or tree. This information will aid in the decision making process for the optimal plot width.
6. Note: If after the survey begins, you realize visibility in stand is limited (<33 feet
[10 m]), count only snags and trees out to 33 feet (10 m) from the line. Wider
plots may be inaccurate in these conditions.
7. Note: If after the survey begins, you realize snag or tree densities are consistently
high (>15 snags or trees/plot), count only snags and trees out to 33 feet (10 m)
from the line. Wider plots may be inefficient in these conditions.
8. Refer to appendix 2 for details on other information collected for each snag
or tree.
9. After pilot survey, count only snags and trees within the boundaries of the chosen
plot size.
V. Data Entry
A. Make backup copies of all files before entering own data.
1. Open the Estimate.xls (Estimatm.xls) file.
2. Rename the Estimate.xls (Estimatm.xls) file with the subwatershed name or
another file name.
3. Enter your data into the newly named file on Sheet 1.
4. Double check data to ensure that the number “9999” has been entered in each
subsegment where no snags or trees were encountered.
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VI.

Computer analysis for stratified landscapes

A. Run Consecutive macro.
1. This sorts data sets by consecutive Segments and Subsegments.
2. Scroll through the entire data set to ensure that two Subsegment plots are
entered for each Segment. For example, Segment 13 should contain
Subsegments 13.1 and Subsegments 13.2
B. Run Formula macro to have “If, then” formulas entered into Width columns.
If a snag or tree meets the criteria that you specify, it will then be included
in the analysis.
1. Specify minimum d.b.h. of snags or trees.
2. Specify minimum height of snags or trees.
3. Specify maximum decay (snags) or structural (trees) class.
4. Specify species of snags or trees.
C. Run Sort macro to separate strata for individual analysis.
D. Run Segment macro to obtain averages, standard deviations, and sample sizes
for each of the four segment (328 feet [100 m]) plots widths based on the criteria
you provided to the Formula macro.
E. Run Subsegment macro to obtain averages, standard deviations, and
sample sizes for each of the four subsegment (164 feet [50 m]) plot widths based
on the criteria you provided to the Formula macro.
VII. Optimal Plot Size Analysis
A. Given mean and variance of each plot size, which one of the eight possible plot
sizes minimizes the number of samples required? Note that if snags or trees were
counted only out to 33 feet (10 m) from the center line, only four
possible plot sizes are available.
B. Given mean and variance of each plot size, which one minimizes the
number of acres (ha) required?
C. Which plot size minimizes the product of the relative variance and
relative cost?
D. Which plot size predicts the lowest Total Cost?
E. Select plot size which seems Optimal given your specific forest conditions.
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VIII. Sample Size Determination
A. Use Sample Size spreadsheet to obtain estimate of total sample size required by
using plot sizes selected above.
B. Collect remaining number of samples, after pilot survey samples, to meet your
objectives.
C. Continue to enter additional data on Sheet 1 as collected.
IX.

Density Analysis

A. Use Density spreadsheet to obtain density estimate and its bound.
B. Use Statistical Test spreadsheet to compare estimated density to targeted density
(optional).
X. Distribution Analysis
A. Use Distribution Index spreadsheet to assess the distribution of snags and trees
across the landscape.
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Appendix 2:
Field Form
Explanations

1. Stratum: Enter the stratum number:
1, 2, 3, or 4.
2. Location: Enter the stand number in
which the plot is contained.
3. Segment: Enter a single whole
number to indicate which 328-foot
(100-m) transect length is being surveyed
(e.g., 1, 2, 3, or 4). No two numbers
within a survey area should be the same.
4. Subsegment: Enter the corresponding
whole number of the Segment that this
164-foot (50-m) transect length is nested
within. Then give the Subsegment an
additional number after a decimal point to
indicate whether the Subsegment is the
first, or second, within this Segment. For
example, the two Subsegments nested
within Segment 1 should be identified as
Subsegment 1.1 and 1.2.
5. Width33(10): This column will be
filled in by the macro for all snags or
trees that meet the target criteria and
are <16.5 feet (5 m) away from the
center line.
6. Width66(20): This column will be filled
in by the macro for all snags or trees that
meet the target criteria and are <33 feet
(10 m) away from the center line.
7. Width99(30): This column will be filled
in by the macro for all snags or trees that
meet the target criteria and are <49 feet
(15 m) away from the center line.
8. Width132(40): This column will be
filled in by the macro for all snags or
trees that meet the target criteria and
are <66 feet (20 m) away from the
center line.
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9. Distance: Enter the perpendicular
distance between the midpoint of the
qualifying snag or tree and the center of
the transect line to the nearest foot (nearest halfmeter). If no snag is encountered
within the entire Subsegment, enter
“9999” under distance. It is critical to
measure distances precisely. If the midpoint of a snag or tree falls directly on the
boundary, include the first one, exclude
the second one, and so on.
10. Species: Enter the corresponding
numeric code of the snag or tree species
encountered (standardized species codes
taken from Stand Exam Program in the
Pacific Northwest Region [USDA Forest
Service 1991]).
Douglas-fir/redwoods:
Douglas-fir (Pseudotsuga menziesii) 202
Redwood (Sequoia sempervirens)
211
True firs:
Pacific silver fir (Abies amabilis)
White fir (A. concolor)
Grand fir (A. grandis)
Subalpine fir (A. lasiocarpa)
California red fir (A. magnifica var.
magnifica)
Shasta red fir(A. magnifica var.
shastensis)
Noble fir (A. procera)

011
015
017
019
020
021
022

Cedars:
Port-Orford-cedar
(Chamaecyparis lawsoniana)
Alaska cedar (C. nootkatensis)
Incense-cedar (Calocedrus decurrens)
Western redcedar (Thuja plicata)

041
042
081
242

Larch:
Western larch (Larix occidentalis)

073

Spruce:
Brewer spruce (P. breweriana)
092
Engelmann spruce (Picea engelmannii) 093
Sitka spruce (P. sitchensis)
098

11. Class: Enter the numeric value for
the appropriate decay or structural class
of the snag or tree encountered. Snag
data should be collected on a data form
separate from large trees. For snags,
the numeric value should increase with
increasing amounts of decay. For
example, Parks and others (1997)
categorized snags into three structural
classes.

Pines:
Lodgepole pine (Pinus contorta)
Jeffrey pine (P. jeffreyi)
Sugar pine (P. lambertiana)
Western white pine (P. monticola)
Ponderosa pine (P. ponderosa)

108
116
117
119
122

Hemlock:
Western hemlock (Tsuga heterophylla) 263
Mountain hemlock (T. mertensiana) 264
Hardwoods:
Bigleaf maple (Acer macrophyllum)
Red alder (Alnus rubra)
Western paper birch ( Betula papyrifera)
Pacific madrone (Arbutus menziessii)
Golden chinkapin (Castanopsis
chrysophylla)
Oregon ash (Fraxinus latifolia)
Tanoak (Lithocarpus densiflorus)
Quaking aspen(Populus tremuloides )
Black cottonwood (P. trichocarpa )
Oregon white oak (Quercus garryana )
California black oak (Q.. kelloggii )
Oregon myrtle (Umbellularia californica)

312
351
376
361
431
542
631
746
747
815
818
981

Other conifers:
Subalpine larch (Larix lyallii )
Cypress (Cupressus )
All junipers (Juniperus )
Pacific yew (Taxus brevifolia )
Knobcone pine (P. attenuata )
Limber pine (P. flexilis )
Whitebark pine (P. albicaulis )

072
050
060
231
103
113
101

A. Snag structural classes
1. Snags that have recently died.
2. Snags that have been dead several
years and have lost some branches
and bark.
3. Snags that have been dead a long
time and lack branches and bark
(except grand fir and Douglas-fir,
which tend to retain bark).
In contrast, numeric values for the
structural class of trees should decrease
with increasing amounts of decay.
For example:
Tree structural classes
1. Hollow
2. Some decay evidence (broken
branch or top, fungi, wildlife signs)
3. Broomed trees
4. Sound
Refer to Bull and others (1997) for
detailed information on delineating
categories and identifying trees useful
to wildlife in the field.
12. D.b.h.: Enter the diameter at breast
height of the snag or tree encountered
using a d.b.h., stick or tape, to the
nearest inch (cm).
13. Height: Enter the height of the snag
or tree to the nearest foot (m).
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14. Cavity: Enter the appropriate numeric code to indicate any nesting use of the
snag or tree under consideration.
1. New cavity indicated by one
or all of following: fresh wood
chips on ground below hole, light
colored wood around entrance,
bird occupying cavity (excavated
or natural).
2. Old cavity: Gray colored chips
on ground below hole, gray colored wood around entrance, no
sign of bird occupying cavity
(excavated or natural).
3. Both old and new cavities
4. Other wildlife use.
5. Unknown. It is not possible to
determine whether any cavities
are present.
6. No cavities found.
15. Foraging: Enter the appropriate
numeric code to indicate any foraging use
of the snag or tree under consideration.
1. New foraging indicated
by light colored wood around
foraging sign, recent scaling.
2. Old foraging indicated by
gray colored wood around
foraging sign.
3. Both old and new foraging.
4. No foraging signs.
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High (>8 snags per acre[3.2/ha])

Low (<2 snags per acre [0.8/ha])

Subsegment66(20)d Moderate

Segment66(20)

Scattered

Clumped

Evenly scattered

Clumped

Evenly scattered

Distribution

Dense regeneration stands

Open grass areas
with treed draws

Widespread beetle kill or
stand replacement burns

Pockets of beetle kill

Recent clearcuts

Examples

d If densities are extremely high such that >15 snags per plot are consistently encountered, Subsegment33(10) plots may be more appropriate.

c If interested in foraging and nesting use in clearcuts, use Segment132(40) plots to encounter more snags.

moderate travel conditions due to downed woody debris, high shrub cover, or moderate slope (≤50 percent slope); difficult refers to low visibility (<33 feet
[10 m]), difficult travel due to large amounts of downed woody debris, high shrub cover, or high slope (≥50 percent).

b Easy forest conditions refer to high visibility (>66 feet [20 m]), easy travel, little slope; moderate refers to medium visibility (approx. 49.5 feet [15m]),

and then conducting an Optimal Plot Size Analysis

a In most forested areas, however, the optimal plot size should be determined by evaluating the density and distribution of snags or trees within the areas

Subsegment66(20) Difficult

Low (<1 snag/acre [0.4/ha])

Medium (5 snags per acre [2/ha])

Moderate

Segment66(20)

Easy-moderate

Low (<1 snag/acre [0.4/ha])

Forest conditionsb Density

Subsegment132(4)c Easy

Recommended
plot size

Table 11–Recommeded plot sizes for presampling plot sizea

Appendix 3:
Recommended
Plot Sizes for
Presampling
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Appendix 4:
Frequently Used
Excel Commands
in Computer
Analysis
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I.

To
1.
2.
3.

start a macro over:
Press Enter or OK until message box with Error appears.
Select End.
Follow directions to restore sheet to its original format.

II.

To restore a sheet to its original format:
1. Select all rows containing data beneath the Grand Total row.
2. Select Delete from the Edit menu.
3. Click on Entire Row.
4. Then activate the cell with the field name SEGMENT (SUBSEGMENT if you
are running the SUBSEGMENT macro).
5. From the Data menu choose Subtotals.
6. Select Remove all.

III.

To
1.
2.
3.
4.

print out results:
Use mouse to highlight area to be printed (Click and drag with mouse).
Select Print from the File menu.
Click on Selection.
Choose OK.

IV.

To
1.
2.
3.
4.
5.

edit a formula:
Activate top cell in column with formula to edit.
Press the function key “F2” at the top of the keyboard.
Change formula to meet your criteria.
Press Enter. (Arrow keys do not work in Edit mode.)
Copy and paste top cell throughout the column.

V.

To
1.
2.
3.
4.

copy and paste:
Highlight range to copy using the mouse. Click and drag for large areas.
Select Copy from the Edit menu.
Highlight area where formula is to be pasted.
Choose Paste from Edit menu.

VI.

To reverse out of a process:
1. Press Escape.

This page has been left blank intentionally.
Document continues on next page.

This page has been left blank intentionally.
Document continues on next page.

Bate, Lisa J.; Garton, Edward O.; Wisdom, Michael J. 1999. Estimating snag and large tree
densities and distributions on a landscape for wildlife management. Gen. Tech. Rep. PNWGTR-425. Portland, OR: U.S. Department of Agriculture, Forest Service, Pacific Northwest
Research Station. 76 p.
We provide efficient and accurate methods for sampling snags and large trees on a landscape to
conduct compliance and effectiveness monitoring for wildlife in relation to the habitat standards
and guidelines on National Forests. Included online are the necessary spreadsheets, macros, and
instructions to conduct all surveys and analyses pertaining to estimation of snag and large tree
densities and distributions at the subwatershed scale. The methods focus on optimizing sampling
effort by choosing a plot size appropriate for the specific forest conditions encountered. Two
methods are available for density analysis. Method one requires sampling until a desired precision level is obtained for a density estimate. Method two is intended for use in areas that have
low snag densities compared to Forest plan targeted densities. After taking a minimum of 60 samples, one may test for a significant difference between the estimated and targeted densities. In
addition, data can be used to calculate a distribution index. The value obtained from the distribution index indicates whether the current distribution of target snags and large trees across a subwatershed is adequate to meet the habitat needs of territorial cavity-nesters and other wildlife
species. Wildlife use also may be evaluated.

Keywords: Density, distribution, foraging, nesting, monitoring, sampling technique, snag, large
tree, woodpecker, wildlife management, wildlife use.
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